
 

Assignment -1 
 
 What are the four fundamental parts of 

computer? Explain it with the help of diagram. 

Ans- Input Unit, CPU, Primary Memory, and Output Unit are the four basic 

components of a computer system. 

Explanation: 

A computer has four main components: Input Units, the central processing 

unit or CPU, the Primary memory, and Output units. 

 Input Unit - The devices to input information, such as a keyboard, and 

mouse.   

 

 CPU - The CPU is further broken up into ALU, Control 

Unit, and Instruction Unit. 



 

 Primary Memory - Computer program instructions converted into machine 

code are stored in primary storage or memory. 

 

 Output Unit - The devices to output information, such as a printer, monitor, 

and speaker. 



 

Q2: Discuss about the classification of  

computers based on size and capacity. 

Ans-  Computers are classified on different parameters, such as, 

storage capacity, processing speed and component (CPU) used 

in computers. Depending upon the components used and 

features of different computers, they are classified into four 

groups, Microcomputer, Mainframe computers and 

Supercomputers  

Q3: What is the meaning of computer 

generation? How many Computer Generations 

are defined? What technologies were/are used? 



Ans- Computer generations are based on when major 

technological changes in computers occurred, like the use of 
vacuum tubes, transistors, and the microprocessor. As of 2020, 

there are five generations of the computer. 

Review each of the generations below for more information and 

examples of computers and technology that fall into each 
generation. 

 First generation (1940 - 1956) 

 Second generation (1956 - 1963) 

 Third generation (1964 - 1971) 

 Fourth generation (1972 - 2010) 

 Fifth generation (2010 to present) 

 Sixth generation (future generations) 

First generation (1940 - 1956) 

 

The first generation of computers used vacuum tubes as a major 

piece of technology. Vacuum tubes were widely used in 
computers from 1940 through 1956. Vacuum tubes were larger 
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components and resulted in first-generation computers being 

quite large in size, taking up a lot of space in a room. Some of 
the first-generation computers took up an entire room. 

The ENIAC is a great example of a first-generation computer. It 
consisted of nearly 20,000 vacuum tubes, 10,000 capacitors, and 

70,000 resistors. It weighed over 30 tons and took up a lot of 
space, requiring a large room to house it. Other examples of 

first-generation computers include the EDSAC, IBM 701, 
and Manchester Mark 1. 

 

Second generation (1956 - 1963) 

 

The second generation of computers saw the use 
of transistors instead of vacuum tubes. Transistors were widely 

used in computers from 1956 to 1963. Transistors were smaller 
than vacuum tubes and allowed computers to be smaller in size, 

faster in speed, and cheaper to build. 

The first computer to use transistors was the TX-0 and was 

introduced in 1956. Other computers that used transistors 
include the IBM 7070, Philco Transac S-1000, and RCA 501. 
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Third generation (1964 - 1971) 

 

The third generation of computers introduced the use 

of IC (integrated circuits) in computers. Using IC's in computers 

helped reduce the size of computers even more than second-
generation computers, and also made them faster. 

Nearly all computers since the mid to late 1960s have utilized 
IC's. While the third generation is considered by many people to 

have spanned from 1964 to 1971, IC's are still used in computers 
today. Over 45 years later, today's computers have deep roots 

going back to the third generation. 
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Fourth generation (1972 - 2010) 

 

The fourth generation of computers took advantage of the 
invention of the microprocessor, more commonly known as a 

CPU. Microprocessors, with integrated circuits, helped make it 
possible for computers to fit easily on a desk and for the 

introduction of the laptop. 

Some of the earliest computers to use a microprocessor include 

the Altair 8800, IBM 5100, and Micral. Today's computers still 
use a microprocessor, despite the fourth generation being 

considered to have ended in 2010. 
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Fifth generation (2010 to present) 

 

The fifth generation of computers is beginning to 
use AI (artificial intelligence), an exciting technology with many 

potential applications around the world. Leaps have been made 
in AI technology and computers, but there is still room for much 

improvement. 

One of the more well-known examples of AI in computers is 

IBM's Watson, which was featured on the TV show Jeopardy as 
a contestant. Other better-known examples include 

Apple's Siri on the iPhone and Microsoft's Cortana on Windows 

8 and Windows 10 computers. The Google search engine also 

utilizes AI to process user searches. 

Sixth generation (future generations) 

As of 2021, most still consider us to be in the fifth generation as 

AI continues to be developed. One possible contender for a 
future sixth generation is with the work being done 

with quantum computers. However, until it becomes more 
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developed and widely used, it's still only a promising 

technology. 

Q4: Differentiate between Volatile & 

Non- Volatile memories 

Ans- Difference between Volatile Memory and 

Non-Volatile Memory 

  

Volatile Memory: 

It is the memory hardware that fetches/stores 
data at a high-speed. It is also referred as 
temporary memory. The data within the volatile 
memory is stored till the system is capable of, 
but once the system is turned off the data within 
the volatile memory is deleted 
automatically. RAM (Random Access 
Memory) and Cache Memory are some 
common examples of volatile memory. Here, 
data fetch/store is fast and economical. 
Non-Volatile Memory: 
It is the type of memory in which data or 
information is not lost within the memory even 
power is shut-down. ROM (Read Only 
Memory) is the most common example of non-
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volatile memory. It’s not economical and slow in 
fetch/store as compared to volatile memory 
however stores higher volume of data. All such 
information that needs to be stored for an 
extended amount of time is stored in non-
volatile memory. Non-volatile memory has a 
huge impact on a system’s storage capacity. 
Below are the differences between volatile and 
non-volatile memory: 

S.NO Volatile Memory 

Non-Volatile 

Memory 

1. 

Volatile memory is 

the type of memory 

in which data is lost 

as it is powered-off. 

Non-volatile 

memory is the type 

of memory in 
which data 

remains stored 

even if it is 

powered-off. 

2. 

Contents of Volatile 

memory is stored 
temporarily. 

Contents of Non-

volatile memory is 

stored 
permanently.  

3. 

It is faster than non-

volatile memory. 

It is slower than 

volatile memory. 

4. RAM(Random ROM(Read Only 



Access Memory) is 

an example of 
volatile memory. 

Memory) is an 

example of non-
volatile memory. 

5. 

In volatile memory, 

data can be easily 
transferred in 

comparison to non-

volatile memory. 

In non-volatile 

memory, data can 

not be easily 
transferred in 

comparison to 

volatile memory. 

6. 

In Volatile memory, 

process can read and 

write. 

In Non-volatile 

memory, process 

can only read. 

7. 

Volatile memory 

generally has less 
storage capacity. 

Non-volatile 

memory generally 

has more storage 

capacity than 
volatile memory. 

8. 

In volatile memory, 
the program’s data 

are stored which are 

currently in process 
by the CPU. 

In non-volatile 

memory, any kind 
of data which has 

to be saved 

permanently are 
stored.  

9. 

Volatile memory is 

more costly per unit 

Non-volatile 

memory is less 



size.  costly per unit 

size.  

10. 

Volatile memory has 

a huge impact on the 
system’s 

performance.  

Non-volatile 

memory has a 

huge impact on a 

system’s storage 
capacity. 
 

Q5: Distinguish among system software, 

application software and open source 

software on the 

basis of their features. 

Ans-Difference between System software and 

Application software. 

Software/CodingSoftware 

EngineeringComputer Programming 

 

As we know that software is a set of 

instructions or programs instructing a computer 



to do specific tasks. Software is basically a 

generic term used to describe computer 

programs. In general Scripts, applications, 

programs and a set of instructions are all terms 

often used to describe software. 

 

Now the basis of language in which software is 

developed and platform which is required for 

its execution we can classified software as in 

two divisions which are System software and 

Application software. Following are some basic 

differences between System software and 

Application software. 

 

Sr. No. Key System Software. Application 

Software. 



1 Definition System Software is the type of 

software which is the interface between 

application software and system. On other hand 

Application Software is the type of software 

which runs as per user request. It runs on the 

platform which is provide by system software. 

2 Development Language In general System 

software are developed in low level language 

which is more compatible with the system 

hardware in order to interact with. While in 

case of Application software high level 

language is used for their development as they 

are developed as some specific purpose 

software. 

3 Usage System software is used for 

operating computer hardware. On other hand 

Application software is used by user to perform 

specific task. 



4 Installation System software are installed 

on the computer when operating system is 

installed. On other hand Application software 

are installed according to user’s requirements. 

5 User interaction As mentioned in above 

points system software are specific to system 

hardware so less or no user interaction 

available in case of system software. On other 

hand in application software user can interacts 

with it as user interface is available in this case. 

6 Dependency System software can run 

independently. It provides platform for running 

application software. On other hand in 

application software can’t run independently. 

They can’t run without the presence of system 

software.. 

7 Examples Some examples of system 

software’s are compiler, assembler, debugger, 



driver, etc. On other hand some examples of 

application software’s are word processor, web 

browser, media player, etc 

Q6. a) Create a file in MS-word to insert a 

paragraph about yourself and save it with file 

name 

“yourself”. Describe all steps involved in it. 

Ans- Every Word project you create—whether 

it’s a personal letter, a TV sitcom script, or a 

thesis in microbiology—begins and ends the 

same way. You start by creating a document, 

and you end by saving your work. Sounds 

simple, but to manage your Word documents 

effectively, you need to know these basics and 

beyond. This chapter shows you all the 

different ways to create a new Word 

document—like starting from an existing 

document or adding text to a predesigned 



template—and how to choose the best one for 

your particular project. 

 

You’ll also learn how to work faster and 

smarter by changing your view of your 

document. If you want, you can use Word’s 

Outline view when you’re brainstorming, and 

then switch to Print view when you’re ready for 

hard copy. This chapter gets you up and 

running with these fundamental tools so you 

can focus on the important stuff—your words. 

 

TIP 

If you’ve used Word before, then you’re 

probably familiar with opening and saving 

documents. Still, you may want to skim this 

chapter to catch up on the differences between 



this version of Word and the ghosts of Word 

past. You’ll grasp some of the big changes just 

by examining the figures. For more detail, 

check out the gray boxes and the notes and 

tips—like this one! 

 

Launching Word 

The first time you launch Word after 

installation, the program asks you to confirm 

your name and initials. This isn’t Microsoft’s 

nefarious plan to pin you down: Word uses this 

information to identify documents that you 

create and modify. Word uses your initials to 

mark your edits when you review and add 

comments to Word documents that other 

people send to you (Section 16.3). 

 



You have three primary ways to fire up Word, 

so use whichever method you find quickest: 

 

Start menu. The Start button in the lower-left 

corner of your screen gives you access to all 

programs on your PC—Word included. To start 

Word, choose Start → All Programs → 
Microsoft Office → Microsoft Office Word. 

 

Quick Launch toolbar. The Quick Launch toolbar 

at the bottom of your screen (just to the right 

of the Start menu) is a great place to start 

programs you use frequently. Microsoft 

modestly assumes that you’ll be using Word a 

lot, so it usually installs the Word icon in the 

Quick Launch toolbar. To start using Word, just 

click the W icon, and voilá! 



 

TIP 

When you don’t see the Quick Launch toolbar, 

here’s how to display it: On the bar at the 

bottom of your screen, right-click an empty 

spot. From the menu that pops up, choose 

Toolbars → Quick Launch. When you’re done, 

icons for some of your programs appear in the 

bottom bar. A single click fires up the program. 

 

Opening a Word document. Once you’ve 

created some Word documents, this method is 

fastest of all, since you don’t have to start 

Word as a separate step. Just open an existing 

Word document, and Word starts itself. Try 

going to Start → My Recent Documents, and 

then, from the list of files, choose a Word 

document. You can also double-click the 



document’s icon on the desktop or wherever it 

lives on your PC. 

 

TIP 

If you need to get familiar with the Start menu, 

Quick Launch toolbar, and other Windows 

features, then pick up a copy of Windows XP: 

The Missing Manual, Second Edition or 

Windows Vista: The Missing Manual. 

 

So, what happens once you’ve got Word’s 

motor running? If you’re a newcomer, you’re 

probably just staring with curiosity. If you’re 

familiar with previous versions of Word, 

though, you may be doing a double take (Figure 

1-1). In Word 2007, Microsoft combined all the 

old menus and toolbars into a new feature 



called the ribbon. Click one of the tabs above 

the ribbon, and you see the command buttons 

change below. The ribbon commands are 

organized into groups, with the name of each 

group listed at the bottom. (See Figure 1-1 for 

more detail on the ribbon.) 

 

Creating a New Document 

When you start Word without opening an 

existing document, the program gives you an 

empty one to work in. If you’re eager to put 

words to page, then type away. Sooner or later, 

though, you’ll want to start another new 

document. Word gives you three ways to do so: 

 

When you start Word 2007 for the first time, it 

may look a little top-heavy. The ribbon takes up 



more real estate than the old menus and 

toolbars. This change may not matter if you 

have a nice big monitor. But if you want to 

reclaim some of that space, you can hide the 

ribbon by double-clicking the active tab. Later, 

when you need to see the ribbon commands, 

just click a tab. 

Figure 1-1. When you start Word 2007 for the 

first time, it may look a little top-heavy. The 

ribbon takes up more real estate than the old 

menus and toolbars. This change may not 

matter if you have a nice big monitor. But if you 

want to reclaim some of that space, you can 

hide the ribbon by double-clicking the active 

tab. Later, when you need to see the ribbon 

commands, just click a tab. 

Creating a new blank document. When you’re 

preparing a simple document—like a two-page 



essay, a note for the babysitter, or a press 

release—a plain, unadorned page is fine. Or, 

when you’re just brainstorming and you’re not 

sure what you want the final document to look 

like, you probably want to start with a blank 

slate or use one of Word’s templates (more on 

that in a moment) to provide structure for your 

text. 

 

Creating a document from an existing 

document. For letters, resumes, and other 

documents that require more formatting, why 

reinvent the wheel? You can save time by using 

an existing document as a starting point 

(Section 1.2.2). When you have a letter format 

that you like, you can use it over and over by 

editing the contents. 

 



Creating a document from a template (Section 

1.2.3). Use a template when you need a 

professional design for a complex document, 

like a newsletter, a contract, or meeting 

minutes. Templates are a lot like forms—the 

margins, formatting, and graphics are already in 

place. All you do is fill in your text. 

 

TIP 

Microsoft provides a mind-boggling number of 

templates with Word, but they’re not the only 

source. You can find loads more on the 

Internet, as described in Section 5.2.1. Your 

employer may even provide official templates 

for company documents. 

 



To start your document in any of the above 

ways, click the Windows logo in the upper-left 

corner of the screen. That’s Office 2007’s new 

Office button. Click it, and a drop-down menu 

opens, revealing commands for creating, 

opening, and saving documents. Next to these 

commands, you see a list of your Word 

documents. This list includes documents that 

are open, as well as those that you’ve recently 

opened. 

 

The Office button is also where you go to print 

and email your documents (Figure 1-2). 

 

The phrase most frequently uttered by 

experienced Word fans the first time they start 

Word 2007 is, “Okay, where’s my File menu?” 

Never fear, the equivalent of the File menu is 



still there—it’s just camouflaged a bit. Clicking 

the Office button (the one that looks like a 

Windows logo) reveals the commands you use 

to create, open, and save Word documents. 

Figure 1-2. The phrase most frequently uttered 

by experienced Word fans the first time they 

start Word 2007 is, “Okay, where’s my File 

menu?” Never fear, the equivalent of the File 

menu is still there—it’s just camouflaged a bit. 

Clicking the Office button (the one that looks 

like a Windows logo) reveals the commands 

you use to create, open, and save Word 

documents. 

Creating a New Blank Document 

Say you want a new blank document, just like 

the one Word shows you when you start the 

program. No problem—here are the steps: 

 



Choose Office button → New. 

 

The New Document dialog box appears. 

 

In the upper-left corner of the large “Create a 

new Word document” panel, click “Blank 

document” (Figure 1-3). 

 

The New Document box presents a seemingly 

endless number of options, but don’t panic. The 

“Blank document” option you want is on the 

left side of the first line. 

 

At the bottom of the New Document dialog 

box, click Create. 

 



The dialog box disappears, and you’re gazing at 

the blank page of a new Word document. 

 

Better get to work. 

 

Open the New Document box (Office button → 
New, or Alt+F, N), and Word gives you several 

ways to create a new document. Click “Blank 

document” to open an empty document, 

similar to the one Word shows when you first 

start the program. Or you can click “New from 

existing” to open a document that you 

previously created under a new name. 

Figure 1-3. Open the New Document box 

(Office button → New, or Alt+F, N), and Word 
gives you several ways to create a new 

document. Click “Blank document” to open an 



empty document, similar to the one Word 

shows when you first start the program. Or you 

can click “New from existing” to open a 

document that you previously created under a 

new name. 

Creating a New Document from an Existing 

Document 

A blank Word document is sort of like a 

shapeless lump of clay. With some work, you 

can mold it to become just about anything. 

Often, however, you can save time by opening 

an existing document that’s similar to the one 

you want to create. Imagine that you write the 

minutes for the monthly meetings of the Chief 

Executive Officer’s Surfing Association (CEOSA). 

When it’s time to write up the June minutes, 

it’s a lot faster to open the minutes from May. 

You keep the boilerplate text and all the 



formatting, but you delete the text that’s 

specific to the previous month. Now all you 

have to do is enter the text for June and save 

the document with a new name: 

JuneMinutes.docx. 

 

NOTE 

The .docx extension on the end of the filename 

is Word 2007’s new version of .doc. The switch 

from three-letter to four-letter filename 

extensions indicates a change in the way Word 

stores documents. (If you need to share 

documents with folks using earlier versions of 

Word, choose Office button → Save As → Word 

97-2003 document when you save the file. See 

the box in Section 1.2.3 for details.) 

 



Word gives you a “New from existing” 

document-creation option to satisfy your desire 

to spend more time surfing and less time 

writing meeting minutes. Here’s how to create 

a new document from an existing document: 

 

Choose Office button → New (Alt+F, N) to open 
the New Document window. Then click “New 

from existing…” (it sits directly below the 

“Blank document” button). 

 

The three dots at the end of the button’s title 

tell you that there’s another dialog box to 

come. And sure enough, when you click “New 

from existing…”, it opens another box, 

appropriately titled New from Existing 

Document (Figure 1-4). This box looks—and 

works—like a standard Windows Open File box. 



It lets you navigate to a specific folder and open 

a file. 

 

On your computer, find the existing document 

you’re using for a model. 

 

You can use the bar on the left to change the 

folder view. Word starts you in your My 

Documents folder, but you can switch to your 

desktop or your My Computer icon by clicking 

the icons on the left. Double-click folder icons 

in the large window to open them and see their 

contents. 

 

Click to select the file, and then click Create 

New (in the lower-right corner). (Alternatively, 



just double-click the file’s icon to open it. This 

trick works in all Open File boxes.) 

 

Instead of the usual Open button at the bottom 

of the box, the button in the New from Existing 

Document box reads Create New—your clue 

that this box behaves differently in one 

important respect: Instead of opening an 

existing file, you’re making a copy of an existing 

file. Once open, the file’s name is something 

like Document2.docx instead of the original 

name. This way, when you save the file, you 

don’t overwrite the original document. (Still, 

it’s best to save it with a new descriptive name 

right away.) 

 

Use the New from Existing Document box to 

find an existing Word document that you’d like 



to open as a model for your new document. 

When you click Create New at bottom-right, 

Word opens a new copy of the document, 

leaving the original untouched. You can modify 

the copy to your heart’s content and save it 

under a different file name. 

Figure 1-4. Use the New from Existing 

Document box to find an existing Word 

document that you’d like to open as a model 

for your new document. When you click Create 

New at bottom-right, Word opens a new copy 

of the document, leaving the original 

untouched. You can modify the copy to your 

heart’s content and save it under a different file 

name. 

TIP 

Windows’ Open File boxes, like New from 

Existing Document, let you do a lot more than 



just find files. In fact, they let you do just about 

anything you can do in Windows Explorer. 

Using keyboard shortcuts, you can cut (Ctrl+X), 

copy (Ctrl+C), and paste (Ctrl+V) files. A right-

click displays a shortcut menu with even more 

commands, letting you rename files, view 

Properties dialog boxes, and much more. You 

can even drag and drop to move files and 

folders. 

 

POWER USERS’ CLINIC: WORD’S NEW FILE 

FORMATS: .DOCX AND .DOCM 

With Office 2007, Microsoft took the drastic 

step of changing its file formats in hopes of 

improving your computer’s security. Malicious 

programmers were using Office’s macros to do 

nasty things to unsuspecting computers. The 

.docx format, the new standard for Word files, 



doesn’t permit macros, making it safe from 

those threats. The .docm format indicates that 

a document contains macros or other bits of 

programming code. When opening one of these 

files, play it safe: If you don’t know who created 

the .docm file, then don’t open it. 

 

The downside of the new file formats is that 

older versions of Word don’t know how to 

open these .docx and .docm documents. To 

open Word 2007 files with an older version 

(even Word 2003), you need to install the 

Microsoft Office Compatibility Pack. 

 

This software fix gives pre-2007 versions of 

Word the power to open documents in the new 

formats. Even then, you may not be able to use 

or edit parts of the file that use new Word 



features (like themes, equations, and content 

controls). To download the free compatibility 

pack, go to www.office.microsoft.com and type 

office 2007 compatibility into the search box at 

the top of the page. 

 

Also, if you’re preparing a Word document for 

someone who’s using an older Word version, 

then you have to save it in a compatible format, 

as described in the tip in Section 1.2.2. 

(Fortunately, the compatibility issue doesn’t go 

both ways: Word 2007 can open old .doc docs 

just fine.) 

 

Creating a New Document from a Template 

Say you’re creating meeting minutes for the 

first time. You don’t have an existing document 

http://www.office.microsoft.com/


to give you a leg up, but you do want to end up 

with handsome, properly formatted minutes. 

Word is at your service—with templates. 

Microsoft provides dozens upon dozens of 

prebuilt templates for everything from 

newsletters to postcards. Remember all the 

busy stuff in the New Document box in Figure 

1-3? About 90 percent of the items in there are 

templates. 

 

In the previous example, where you use an 

existing document to create the meeting 

minutes for the Chief Executive Officer’s Surfing 

Association (CEOSA), each month you open the 

minutes from the previous month. You delete 

the information that pertains to the previous 

month and enter the current month’s minutes. 

A template works pretty much the same way, 



except it’s a generic document, designed to be 

adaptable to lots of different situations. You 

just open it and add your text. The structure, 

formatting, graphics, colors, and other doodads 

are already in place. 

 

NOTE 

The subject of Word templates is a lengthy one, 

especially when it comes to creating your own, 

so there’s a whole chapter devoted to that 

topic—Chapter 20. 

 

Here’s how to get some help from one of 

Microsoft’s templates for meeting minutes: 

 

Choose Office button → New (Alt+F, N) to open 
the New Document window. 



 

On the left of the New Document box is a 

Template Categories list. The top entry on this 

list is Installed Templates—the ones Word has 

installed on your computer. 

 

You could use any of these, but you also have a 

world of choice waiting for you online. On its 

Web site, Microsoft offers hundreds of 

templates for all sorts of documents, and you 

can access them right from the New Document 

box. If you have a fast Internet connection, 

then it’s just as quick and easy to use an online 

template as it is using the ones stored on your 

computer. In fact, you’ll use an online template 

for this example. 

 



NOTE 

If you can’t connect to the Internet right now, 

then simply choose one of the installed 

templates instead. Click Create, and then skip 

to step 4. 

 

Scroll down the Template Categories list to the 

Microsoft Office Online heading. Under this 

heading, select Minutes. 

 

In the center pane, you’ll see all different types 

of minutes templates, from PTA minutes to 

Annual shareholder’s meeting minutes (Figure 

1-5). When you click a template’s icon, a 

preview appears in the pane on the right. 

 



The New Document box lists prebuilt templates 

that live at Microsoft Office Online in categories 

like Agendas, Brochures, Calendars, and 

Minutes. Below the thumbnail you see an 

estimate of how long it takes to download the 

template from the Microsoft Office Online Web 

site. A rating, from 0 to 5 stars, tells you what 

other people think of the template (the rating 

system is kind of like the one at Amazon.com). 

Figure 1-5. The New Document box lists 

prebuilt templates that live at Microsoft Office 

Online in categories like Agendas, Brochures, 

Calendars, and Minutes. Below the thumbnail 

you see an estimate of how long it takes to 

download the template from the Microsoft 

Office Online Web site. A rating, from 0 to 5 

stars, tells you what other people think of the 

template (the rating system is kind of like the 

one at Amazon.com). 



When you’re done perusing the various styles, 

click the Formal Meeting Minutes icon. (After 

all, CEOSA is a very formal organization.) Then 

click Download. 

 

Word downloads and opens the document. 

 

Start writing up the minutes for the CEO 

Surfers. 

 

To follow the template’s structure, replace all 

the words in square brackets ([ ]) with text 

relevant to CEOSA. 

 

TIP 



If you’d rather not download the Formal 

Meeting Minutes template every time you use 

it, then you can save the file on your computer 

as a Word template. The steps for saving files 

are just around the corner in Section 1.5.  

 

Q6 b) Write steps regarding followings 

 To change the font style 

 To change the font size 

 To change the font color 

 To highlight (in yellow) the line that 

reads  need to get IMS s address .  

Ans-Changing font style, size and color 

 

  



 

The <font> tag is used to change the style, size 

and color of text. It is also a container tag. It is 

generally used for changing the appearance of 

a short segment of text. Before using <font>, 

you should have the knowledge about fonts. 

 

A font is a named set of certain style of 

character and number. Each font looks 

different from other fonts. Generally some 

fonts are used for specific purpose. For 

example, Times New Roman is a style of font 

usually used for preparing office documents. 

Arial is another font style which is used for 

publishing work. Variety of fonts available in 

internet at free of cost. 

 



Generally, a browser shows the contents as 

default system font setting. Every system has 

different font setting with another system. 

 

The general form of <font> tag with attributes: 

 

<font face= “font_name” size=value 

color=color_name / color_code> 

 

        Text to be displayed 

 

</font> 

 

•         The face is an attribute to set different 
font style. The name of a font has multiple 



words it should be specified within double 

quote. 

 

•         The size attribute is used to set size of 
the text. The size can have an absolute value 

from 1 to 7. These predefined sizes are known 

as virtual size. Each virtual size is successively 

20% larger than the previous one. 

 

The color attribute is used to set the color to 

the text. As you leant earlier color name or 

color code in hexadecimal may be used. 

 

 

 



Illustration 11.8 HTML code to change font 

properties 

<html> 

 

<head> 

 

        <title> Changing Font Properties </title> 

 

</head> 

 

<body> 

 

        <font face="Arial Black" size=1 color=red> 

Font Size 1 </font> <br> 

 



        <font face="Arial Black" size=2 color=blue> 

Font Size 2 </font> <br> 

 

        <font face="Arial Black" size=3 

color=green> Font Size 3 </font> <br> 

 

        <font face="Arial Black" size=4 

color=yellow> Font Size 4 </font> <br> 

 

        <font face="Arial Black" size=5 color=pink> 

Font Size 5 </font> <br> 

 

        <font face="Arial Black" size=6 color=red> 

Font Size 6 </font> <br> 

 



        <font face="Arial Black" size=7 color=blue> 

Font Size 7 </font> <br> 

 

</body> 

 

</html> 

 

The output will be: 

 

 

Note: The <font> tag is not supported by 

HTML5. 

 

  

 



Multiple fonts with face attribute: 

As you learnt already, the face attribute of font 

tag is used to change font style of a segment of 

text. In face attribute, you can assign more than 

one font-name at a time within double quotes 

with comma. For example, 

 

<font face = "Bookman old style1, Broadway1, 

Forte, Arial"> 

 

Welcome to HTML 

 

</font> 

 

Browser first tries to find out whether the font-

name in the list is supported or not. If the first 



font is not supported by the browser, then it 

displays the text in second font, otherwise it 

will display next one. If no font in the list is 

supported, then the browser display the in the 

default font. 

 

In the above code, consider the font names 

“Bookman old style1” and “Broadway1” are not 

supported by any browser. (Because, the 

names has been changed). So, the text 

“Welcome to HTML” will be displayed in 

“Forte” style. If your browser not supported 

“Forte” font, the text will be displayed in “Arial” 

font, otherwise the browser shows the text as 

in default font setting. In the case of Internet 

explorer, the “Times New Roman” is the default 

font to display the contents. 



Q7. Create a file in MS-Word for the following 

document and save it with file name 

‘ms_word’. Describe 

all steps involved in it.  

Ans- Every Word project you create—whether it’s 

a personal letter, a TV sitcom script, or a thesis 

in microbiology—begins and ends the same 

way. You start by creating a document, and you 

end by saving your work. Sounds simple, but to 

manage your Word documents effectively, you 

need to know these basics and beyond. This 

chapter shows you all the different ways to 

create a new Word document—like starting 

from an existing document or adding text to a 

predesigned template—and how to choose the 

best one for your particular project. 

 



You’ll also learn how to work faster and 

smarter by changing your view of your 

document. If you want, you can use Word’s 

Outline view when you’re brainstorming, and 

then switch to Print view when you’re ready for 

hard copy. This chapter gets you up and 

running with these fundamental tools so you 

can focus on the important stuff—your words. 

 

TIP 

If you’ve used Word before, then you’re 

probably familiar with opening and saving 

documents. Still, you may want to skim this 

chapter to catch up on the differences between 

this version of Word and the ghosts of Word 

past. You’ll grasp some of the big changes just 

by examining the figures. For more detail, 



check out the gray boxes and the notes and 

tips—like this one! 

 

Launching Word 

The first time you launch Word after 

installation, the program asks you to confirm 

your name and initials. This isn’t Microsoft’s 

nefarious plan to pin you down: Word uses this 

information to identify documents that you 

create and modify. Word uses your initials to 

mark your edits when you review and add 

comments to Word documents that other 

people send to you (Section 16.3). 

 

You have three primary ways to fire up Word, 

so use whichever method you find quickest: 

 



Start menu. The Start button in the lower-left 

corner of your screen gives you access to all 

programs on your PC—Word included. To start 

Word, choose Start → All Programs → 
Microsoft Office → Microsoft Office Word. 

 

Quick Launch toolbar. The Quick Launch toolbar 

at the bottom of your screen (just to the right 

of the Start menu) is a great place to start 

programs you use frequently. Microsoft 

modestly assumes that you’ll be using Word a 

lot, so it usually installs the Word icon in the 

Quick Launch toolbar. To start using Word, just 

click the W icon, and voilá! 

 

TIP 



When you don’t see the Quick Launch toolbar, 

here’s how to display it: On the bar at the 

bottom of your screen, right-click an empty 

spot. From the menu that pops up, choose 

Toolbars → Quick Launch. When you’re done, 

icons for some of your programs appear in the 

bottom bar. A single click fires up the program. 

 

Opening a Word document. Once you’ve 

created some Word documents, this method is 

fastest of all, since you don’t have to start 

Word as a separate step. Just open an existing 

Word document, and Word starts itself. Try 

going to Start → My Recent Documents, and 
then, from the list of files, choose a Word 

document. You can also double-click the 

document’s icon on the desktop or wherever it 

lives on your PC. 



 

TIP 

If you need to get familiar with the Start menu, 

Quick Launch toolbar, and other Windows 

features, then pick up a copy of Windows XP: 

The Missing Manual, Second Edition or 

Windows Vista: The Missing Manual. 

 

So, what happens once you’ve got Word’s 

motor running? If you’re a newcomer, you’re 

probably just staring with curiosity. If you’re 

familiar with previous versions of Word, 

though, you may be doing a double take (Figure 

1-1). In Word 2007, Microsoft combined all the 

old menus and toolbars into a new feature 

called the ribbon. Click one of the tabs above 

the ribbon, and you see the command buttons 

change below. The ribbon commands are 



organized into groups, with the name of each 

group listed at the bottom. (See Figure 1-1 for 

more detail on the ribbon.) 

 

Creating a New Document 

When you start Word without opening an 

existing document, the program gives you an 

empty one to work in. If you’re eager to put 

words to page, then type away. Sooner or later, 

though, you’ll want to start another new 

document. Word gives you three ways to do so: 

 

When you start Word 2007 for the first time, it 

may look a little top-heavy. The ribbon takes up 

more real estate than the old menus and 

toolbars. This change may not matter if you 

have a nice big monitor. But if you want to 



reclaim some of that space, you can hide the 

ribbon by double-clicking the active tab. Later, 

when you need to see the ribbon commands, 

just click a tab. 

Figure 1-1. When you start Word 2007 for the 

first time, it may look a little top-heavy. The 

ribbon takes up more real estate than the old 

menus and toolbars. This change may not 

matter if you have a nice big monitor. But if you 

want to reclaim some of that space, you can 

hide the ribbon by double-clicking the active 

tab. Later, when you need to see the ribbon 

commands, just click a tab. 

Creating a new blank document. When you’re 

preparing a simple document—like a two-page 

essay, a note for the babysitter, or a press 

release—a plain, unadorned page is fine. Or, 

when you’re just brainstorming and you’re not 



sure what you want the final document to look 

like, you probably want to start with a blank 

slate or use one of Word’s templates (more on 

that in a moment) to provide structure for your 

text. 

 

Creating a document from an existing 

document. For letters, resumes, and other 

documents that require more formatting, why 

reinvent the wheel? You can save time by using 

an existing document as a starting point 

(Section 1.2.2). When you have a letter format 

that you like, you can use it over and over by 

editing the contents. 

 

Creating a document from a template (Section 

1.2.3). Use a template when you need a 

professional design for a complex document, 



like a newsletter, a contract, or meeting 

minutes. Templates are a lot like forms—the 

margins, formatting, and graphics are already in 

place. All you do is fill in your text. 

 

TIP 

Microsoft provides a mind-boggling number of 

templates with Word, but they’re not the only 

source. You can find loads more on the 

Internet, as described in Section 5.2.1. Your 

employer may even provide official templates 

for company documents. 

 

To start your document in any of the above 

ways, click the Windows logo in the upper-left 

corner of the screen. That’s Office 2007’s new 

Office button. Click it, and a drop-down menu 



opens, revealing commands for creating, 

opening, and saving documents. Next to these 

commands, you see a list of your Word 

documents. This list includes documents that 

are open, as well as those that you’ve recently 

opened. 

 

The Office button is also where you go to print 

and email your documents (Figure 1-2). 

 

The phrase most frequently uttered by 

experienced Word fans the first time they start 

Word 2007 is, “Okay, where’s my File menu?” 

Never fear, the equivalent of the File menu is 

still there—it’s just camouflaged a bit. Clicking 

the Office button (the one that looks like a 

Windows logo) reveals the commands you use 

to create, open, and save Word documents. 



Figure 1-2. The phrase most frequently uttered 

by experienced Word fans the first time they 

start Word 2007 is, “Okay, where’s my File 

menu?” Never fear, the equivalent of the File 

menu is still there—it’s just camouflaged a bit. 

Clicking the Office button (the one that looks 

like a Windows logo) reveals the commands 

you use to create, open, and save Word 

documents. 

Creating a New Blank Document 

Say you want a new blank document, just like 

the one Word shows you when you start the 

program. No problem—here are the steps: 

 

Choose Office button → New. 

 

The New Document dialog box appears. 



 

In the upper-left corner of the large “Create a 

new Word document” panel, click “Blank 

document” (Figure 1-3). 

 

The New Document box presents a seemingly 

endless number of options, but don’t panic. The 

“Blank document” option you want is on the 

left side of the first line. 

 

At the bottom of the New Document dialog 

box, click Create. 

 

The dialog box disappears, and you’re gazing at 

the blank page of a new Word document. 

 



Better get to work. 

 

Open the New Document box (Office button → 
New, or Alt+F, N), and Word gives you several 

ways to create a new document. Click “Blank 

document” to open an empty document, 

similar to the one Word shows when you first 

start the program. Or you can click “New from 

existing” to open a document that you 

previously created under a new name. 

Figure 1-3. Open the New Document box 

(Office button → New, or Alt+F, N), and Word 
gives you several ways to create a new 

document. Click “Blank document” to open an 

empty document, similar to the one Word 

shows when you first start the program. Or you 

can click “New from existing” to open a 



document that you previously created under a 

new name. 

Creating a New Document from an Existing 

Document 

A blank Word document is sort of like a 

shapeless lump of clay. With some work, you 

can mold it to become just about anything. 

Often, however, you can save time by opening 

an existing document that’s similar to the one 

you want to create. Imagine that you write the 

minutes for the monthly meetings of the Chief 

Executive Officer’s Surfing Association (CEOSA). 

When it’s time to write up the June minutes, 

it’s a lot faster to open the minutes from May. 

You keep the boilerplate text and all the 

formatting, but you delete the text that’s 

specific to the previous month. Now all you 

have to do is enter the text for June and save 



the document with a new name: 

JuneMinutes.docx. 

 

NOTE 

The .docx extension on the end of the filename 

is Word 2007’s new version of .doc. The switch 

from three-letter to four-letter filename 

extensions indicates a change in the way Word 

stores documents. (If you need to share 

documents with folks using earlier versions of 

Word, choose Office button → Save As → Word 
97-2003 document when you save the file. See 

the box in Section 1.2.3 for details.) 

 

Word gives you a “New from existing” 

document-creation option to satisfy your desire 

to spend more time surfing and less time 



writing meeting minutes. Here’s how to create 

a new document from an existing document: 

 

Choose Office button → New (Alt+F, N) to open 
the New Document window. Then click “New 

from existing…” (it sits directly below the 

“Blank document” button). 

 

The three dots at the end of the button’s title 

tell you that there’s another dialog box to 

come. And sure enough, when you click “New 

from existing…”, it opens another box, 

appropriately titled New from Existing 

Document (Figure 1-4). This box looks—and 

works—like a standard Windows Open File box. 

It lets you navigate to a specific folder and open 

a file. 



 

On your computer, find the existing document 

you’re using for a model. 

 

You can use the bar on the left to change the 

folder view. Word starts you in your My 

Documents folder, but you can switch to your 

desktop or your My Computer icon by clicking 

the icons on the left. Double-click folder icons 

in the large window to open them and see their 

contents. 

 

Click to select the file, and then click Create 

New (in the lower-right corner). (Alternatively, 

just double-click the file’s icon to open it. This 

trick works in all Open File boxes.) 

 



Instead of the usual Open button at the bottom 

of the box, the button in the New from Existing 

Document box reads Create New—your clue 

that this box behaves differently in one 

important respect: Instead of opening an 

existing file, you’re making a copy of an existing 

file. Once open, the file’s name is something 

like Document2.docx instead of the original 

name. This way, when you save the file, you 

don’t overwrite the original document. (Still, 

it’s best to save it with a new descriptive name 

right away.) 

 

Use the New from Existing Document box to 

find an existing Word document that you’d like 

to open as a model for your new document. 

When you click Create New at bottom-right, 

Word opens a new copy of the document, 



leaving the original untouched. You can modify 

the copy to your heart’s content and save it 

under a different file name. 

Figure 1-4. Use the New from Existing 

Document box to find an existing Word 

document that you’d like to open as a model 

for your new document. When you click Create 

New at bottom-right, Word opens a new copy 

of the document, leaving the original 

untouched. You can modify the copy to your 

heart’s content and save it under a different file 

name. 

TIP 

Windows’ Open File boxes, like New from 

Existing Document, let you do a lot more than 

just find files. In fact, they let you do just about 

anything you can do in Windows Explorer. 

Using keyboard shortcuts, you can cut (Ctrl+X), 



copy (Ctrl+C), and paste (Ctrl+V) files. A right-

click displays a shortcut menu with even more 

commands, letting you rename files, view 

Properties dialog boxes, and much more. You 

can even drag and drop to move files and 

folders. 

 

POWER USERS’ CLINIC: WORD’S NEW FILE 

FORMATS: .DOCX AND .DOCM 

With Office 2007, Microsoft took the drastic 

step of changing its file formats in hopes of 

improving your computer’s security. Malicious 

programmers were using Office’s macros to do 

nasty things to unsuspecting computers. The 

.docx format, the new standard for Word files, 

doesn’t permit macros, making it safe from 

those threats. The .docm format indicates that 

a document contains macros or other bits of 



programming code. When opening one of these 

files, play it safe: If you don’t know who created 

the .docm file, then don’t open it. 

 

The downside of the new file formats is that 

older versions of Word don’t know how to 

open these .docx and .docm documents. To 

open Word 2007 files with an older version 

(even Word 2003), you need to install the 

Microsoft Office Compatibility Pack. 

 

This software fix gives pre-2007 versions of 

Word the power to open documents in the new 

formats. Even then, you may not be able to use 

or edit parts of the file that use new Word 

features (like themes, equations, and content 

controls). To download the free compatibility 

pack, go to www.office.microsoft.com and type 

http://www.office.microsoft.com/


office 2007 compatibility into the search box at 

the top of the page. 

 

Also, if you’re preparing a Word document for 

someone who’s using an older Word version, 

then you have to save it in a compatible format, 

as described in the tip in Section 1.2.2. 

(Fortunately, the compatibility issue doesn’t go 

both ways: Word 2007 can open old .doc docs 

just fine.) 

 

Creating a New Document from a Template 

Say you’re creating meeting minutes for the 

first time. You don’t have an existing document 

to give you a leg up, but you do want to end up 

with handsome, properly formatted minutes. 

Word is at your service—with templates. 



Microsoft provides dozens upon dozens of 

prebuilt templates for everything from 

newsletters to postcards. Remember all the 

busy stuff in the New Document box in Figure 

1-3? About 90 percent of the items in there are 

templates. 

 

In the previous example, where you use an 

existing document to create the meeting 

minutes for the Chief Executive Officer’s Surfing 

Association (CEOSA), each month you open the 

minutes from the previous month. You delete 

the information that pertains to the previous 

month and enter the current month’s minutes. 

A template works pretty much the same way, 

except it’s a generic document, designed to be 

adaptable to lots of different situations. You 

just open it and add your text. The structure, 



formatting, graphics, colors, and other doodads 

are already in place. 

 

NOTE 

The subject of Word templates is a lengthy one, 

especially when it comes to creating your own, 

so there’s a whole chapter devoted to that 

topic—Chapter 20. 

Here’s how to get some help from one of 

Microsoft’s templates for meeting minutes: 

Q8. Create a file in MS-word for the following 

document and save it with file name 

‘equations’. Describe 

all steps involved in it. 

Ans-Open an OpenDocument Text file in Word 

Click the File tab. 



 

Click Open. 

 

Click Browse, 

 

To see only the files saved in the 

OpenDocument format, click the list of file 

types next to the File name box, and then click 

OpenDocument Text. 

 

Click the file you want to open, and then click 

Open. 

 

Tip: To open the file, you can also double-click 

it after you find it. 

 



Note: When you open an OpenDocument Text 

file in Word, it might not have the same 

formatting as it did in the original application it 

was created in. This is because of the 

differences between applications that use the 

OpenDocument Format. 

 

Top of page 

 

Save a Word document in OpenDocument Text 

format 

Important: If you want to keep a Word version 

of your file, you must first save the file as a 

Word document, for example, in .docx file 

format, and then save it again in the 

OpenDocument Text (.odt) format. 

 



Click the File tab. 

 

Click Save As. 

 

Click Browse, and then select the location 

where you want to save your file. 

 

In the Save as type list, click OpenDocument 

Text. 

 

Give your file a name, and then save it. 

 

Top of page 

 

Learn more about the OpenDocument Format 



When you open or save documents in the 

OpenDocument Text (.odt) format, some 

formatting might be lost. This is because of the 

different features and options, such as 

formatting, that OpenDocument Text 

applications and Word support. For more 

information about the differences between the 

OpenDocument Text format and the Word 

format, see Differences between the 

OpenDocument Text (.odt) format and the 

Word (.docx) format. 

 

Tips 

Before sending a file to someone else, you 

might want to close the file and open it again to 

see what it looks like in OpenDocument Text 

(.odt) format. 

 



When you collaborate on a document shared 

between Word and another word processing 

application, such as Google Docs or 

OpenOffice.org Writer, think of writing (the 

words) and formatting (the look) as different 

tasks. Complete as much of the writing as 

possible without applying formatting to the text 

and save the formatting until the end. This 

allows you to focus on the writing while 

minimizing the loss of formatting as you switch 

between the OpenDocument Text format and 

Word format. 

Q9. Create a file in MS-word that convert 

existing highlight text to table as shown below 

and save it as 

file name ‘text_to_table’. Describe all steps 

involved in it 



Ans- With Word on your PC, Mac, or mobile device, 

you can: 

Create documents from scratch, or a template. 

Add text, images, art, and videos. 

Research a topic and find credible sources. 

Access your documents from a computer, tablet, or 

phone with OneDrive. 

Share your documents, and work with others. 

Track and review changes. 

Create a document 

On the File tab, click New. 

In the Search for online templates box, enter the 

type of document you want to create and press 

ENTER. 

Tip: To start from scratch, select Blank document. 

Or, for practice using Word features, try a learning 



guide like Welcome to Word, Insert your first table 

of contents, and more. 

Online templates in Word 

Add and format text 

Place the cursor and type some text. 

To format, select the text and then select an option: 

Bold, Italic, Bullets, Numbering, and more. 

Add and format text in Word 

Add Pictures, Shapes, SmartArt, Chart, and more 

Select the Insert tab. 

Select what you want to add: 

Tables - select Tables, hover over the size you want, 

and select it. 

Pictures - select Pictures, browse for the picture you 

want, and select Insert. 

Online Pictures - select Online Pictures, search and 

choose the picture you want, and select Insert. 



Shapes - select Shapes, and then select a shape 

from the drop-down. 

Icons - select Icons, choose the one you want, and 

select Insert. 

3D Models - select 3D Models, choose from a file or 

online source, go to the image you want, and select 

Insert. 

SmartArt - select SmartArt, choose a SmartArt 

Graphic, and select OK. 

Chart - select Chart, select the chart you want, and 

select OK. 

Screenshot - select Screenshot and select one from 

the drop-down. 

Q10. Create a file in MS-Word to insert a table in 

the document. Describe all steps involved in it.  

Ans- The basic steps for creating a standard table in 

Microsoft Word (2013) are: 

1. Open a blank Word document 



2. In the top ribbon, press Insert 

3. Click on the Table button 

4. Either use the diagram to select the number of 

columns and rows you need, or click Insert Table 

and a dialog box will appear where you can specify 

the number of columns and rows. 

5. The blank table will now appear on the page. 

Alter it as necessary. Standard features like bold, 

italics, and underline are still available! These items 

may be helpful for creating headings or calling out 

certain items in the table. 

6. Follow these instructions for ensuring your table 

meets APA formatting guidelines. 

Need additional help? The tutoring service has self-

paced table and chart lessons/tutorials within 

SkillSurfer. Follow these steps to access: 

1. Log into the tutoring service (click on the blue 

hyperlink to the left to login!) 



2. Click on SkillSurfer 

3. Click on Computers and Technology 

4. Click on Intermediate underneath Microsoft 

Word 

5. Select Creating Tables and Charts 

6. Choose the exact item(s) you wish to learn about 

(likely Creating Tables from Scratch). 

Q11. Create a following worksheet in MS-excel and 

save it with name ‘book1’.  

Ans-  The world’s most popular spreadsheet 

program is now more powerful than ever, but it’s 

also more complex. That’s where this Missing 

Manual comes in. With crystal-clear explanations 

and hands-on examples, Excel 2013: The Missing 

Manual shows you how to master Excel so you can 

easily track, analyze, and chart your data. You’ll be 

using new features like PowerPivot and Flash Fill in 

no time. 



The important stuff you need to know: 

Go from novice to ace. Learn how to analyze your 

data, from writing your first formula tocharting your 

results. 

Illustrate trends. Discover the clearest way to 

present your data using Excel’s new Quick Analysis 

feature. 

Broaden your analysis. Use pivot tables, slicers, and 

timelines to examine your data from different 

perspectives. 

Import data. Pull data from a variety of sources, 

including website data feeds and corporate 

databases. 

Work from the Web. Launch and manage your 

workbooks on the road, using the new Excel Web 

App. 

Share your worksheets. Store Excel files on SkyDrive 

and collaborate with colleagues on Facebook, 

Twitter, and LinkedIn. 



Master the new data model. Use PowerPivot to 

work with millions of rows of data. 

Make calculations. Review financial data, use math 

and scientific formulas, and perform statistical 

analyses.  

Q12. Calculate the following things of a range 

(C2:C11) of data in the worksheet created in 

question no 

10. 

 the sum of the marks using AutoSum in a 

range of cells (C2:C11) 

 average of the marks in a range of cells 

(C2:C11) 

 highest marks in a range of cells (C2:C11) 

 minimum marks in a range of cells (C2:C11) 

Ans- You can use a simple formula to sum 

numbers in a range (a group of cells), but the 



SUM function is easier to use when you’re 

working with more than a few numbers. For 

example =SUM(A2:A6) is less likely to have 

typing errors than =A2+A3+A4+A5+A6. 

 

Using SUM with two ranges of numbers 

 

Here’s a formula that uses two cell ranges: 

=SUM(A2:A4,C2:C3) sums the numbers in 

ranges A2:A4 and C2:C3. You’d press Enter to 

get the total of 39787. 

 

To create the formula: 

 

Type =SUM in a cell, followed by an opening 

parenthesis (. 



 

To enter the first formula range, which is called 

an argument (a piece of data the formula needs 

to run), type A2:A4 (or select cell A2 and drag 

through cell A6). 

 

Type a comma (,) to separate the first argument 

from the next. 

 

Type the second argument, C2:C3 (or drag to 

select the cells). 

 

Type a closing parenthesis ), and then press 

Enter. 

 



Each argument can be a range, a number, or 

single cell references, all separated by commas. 

 

=SUM(A2:A4,2429,10482) 

 

=SUM(4823,A3:A4,C2:C3) 

 

=SUM(4823,12335,9718,C2:C3) 

 

=SUM(A2,A3,A4,2429,10482) 

 

Tip:  If you need to sum columns or rows of 

numbers next to each other, use AutoSum to 

sum numbers. 

 



Give it a try 

If you want to play around with our sample 

data, here’s some data to use. 

 

You can see how the SUM function works by 

copying the following table into a worksheet 

and pasting it into cell A1. 

 

Data 

 

-5 

 

15 

 

30 



 

'5 

 

TRUE 

 

Formula 

 

Description 

 

Result 

 

=SUM(3, 2) 

 

Adds 3 and 2. 

 



5 

 

=SUM("5", 15, TRUE) 

 

Adds 5, 15 and 1. The text value "5" is first 

translated into a number, and the logical value 

TRUE is first translated into the number 1. 

 

21 

 

=SUM(A2:A4) 

 

Adds the values in cells A2 through A4. 

 

40 



 

=SUM(A2:A4, 15) 

 

Adds the values in cells A2 through A4, and 

then adds 15 to that result. 

 

55 

 

=SUM(A5,A6, 2) 

 

Adds the values in cells A5 and A6, and then 

adds 2 to that result. Because non-numeric 

values in references are not translated — the 

value in cell A5 ('5) and the value in cell A6 

(TRUE) are both treated as text — the values in 

those cells are ignored.  -2 



Q13 a) Describe various steps involved in the 

following 

 To modify column width of a worksheet 

 To modify the row height of a worksheet 

 To delete rows and columns of a worksheet 

Ans-To modify column width: 

In our example below, column C is too narrow 

to display all of the content in these cells. We 

can make all of this content visible by changing 

the width of column C. 

Position the mouse over the column line in the 

column heading so the cursor becomes a 

double arrow. 

positioning the mouse over the column line 

Click and drag the mouse to increase or 

decrease the column width. 



increasing the column width 

Release the mouse. The column width will be 

changed. 

the resized column 

With numerical data, the cell will display pound 

signs (#######) if the column is too narrow. 

Simply increase the column width to make the 

data visible. 

To AutoFit column width: 

The AutoFit feature will allow you to set a 

column's width to fit its content automatically. 

Position the mouse over the column line in the 

column heading so the cursor becomes a 

double arrow. 

autofitting the column width 



Double-click the mouse. The column width will 

be changed automatically to fit the content. 

the autofit column width 

You can also AutoFit the width for several 

columns at the same time. Simply select the 

columns you want to AutoFit, then select the 

AutoFit Column Width command from the 

Format drop-down menu on the Home tab. This 

method can also be used for row height. 

autofitting column width for multiple columns 

To modify row height: 

Position the cursor over the row line so the 

cursor becomes a double arrow. 

hovering over a row line 

Click and drag the mouse to increase or 

decrease the row height. 



decreasing the row height  

Release the mouse. The height of the selected 

row will be changed. 

the new row height 

To modify all rows or columns: 

Instead of resizing rows and columns 

individually, you can modify the height and 

width of every row and column at the same 

time. This method allows you to set a uniform 

size for every row and column in your 

worksheet. In our example, we will set a 

uniform row height. 

Locate and click the Select All button just below 

the name box to select every cell in the 

worksheet. 

selecting all cells in a worksheet 



Position the mouse over a row line so the 

cursor becomes a double arrow. 

Click and drag the mouse to increase or 

decrease the row height, then release the 

mouse when you are satisfied. The row height 

will be changed for the entire worksheet. 

the new, uniform row height 

Inserting, deleting, moving, and hiding 

After you've been working with a workbook for 

a while, you may find that you want to insert 

new columns or rows, delete certain rows or 

columns, move them to a different location in 

the worksheet, or even hide them. 

To insert rows: 

Select the row heading below where you want 

the new row to appear. In this example, we 



want to insert a row between rows 4 and 5, so 

we'll select row 5. 

selecting row 5 

Click the Insert command on the Home tab. 

clicking the Insert command 

The new row will appear above the selected 

row. 

the newly inserted row 

When inserting new rows, columns, or cells, 

you will see a paintbrush icon next to the 

inserted cells. This button allows you to choose 

how Excel formats these cells. By default, Excel 

formats inserted rows with the same 

formatting as the cells in the row above. To 

access more options, hover your mouse over 

the icon, then click the drop-down arrow. 

choosing more insert formatting options 



To insert columns: 

Select the column heading to the right of where 

you want the new column to appear. For 

example, if you want to insert a column 

between columns D and E, select column E. 

selecting column E 

Click the Insert command on the Home tab. 

clicking the Insert command 

The new column will appear to the left of the 

selected column. 

the newly inserted column 

When inserting rows and columns, make sure 

you select the entire row or column by clicking 

the heading. If you select only a cell in the row 

or column, the Insert command will only insert 

a new cell. 



To delete a row or column: 

It's easy to delete a row or column that you no 

longer need. In our example we'll delete a row, 

but you can delete a column the same way. 

Select the row you want to delete. In our 

example, we'll select row 9. 

selecting row 9 

Click the Delete command on the Home tab. 

clicking the delete command 

The selected row will be deleted, and those 

around it will shift. In our example, row 10 has 

moved up, so it's now row 9. 

the shifted rows after deleting 

It's important to understand the difference 

between deleting a row or column and simply 

clearing its contents. If you want to remove the 



content from a row or column without causing 

others to shift, right-click a heading, then select 

Clear Contents from the drop-down menu. 

clearing the contents of a row instead of 

deleting 

To move a row or column: 

Sometimes you may want to move a column or 

row to rearrange the content of your 

worksheet. In our example we'll move a 

column, but you can move a row in the same 

way. 

Select the desired column heading for the 

column you want to move. 

selecting a column to move 

Click the Cut command on the Home tab, or 

press Ctrl+X on your keyboard. 

selecting the Cut command 



Select the column heading to the right of where 

you want to move the column. For example, if 

you want to move a column between columns 

E and F, select column F. 

selecting an adjacent column to insert the cut 

cells 

Click the Insert command on the Home tab, 

then select Insert Cut Cells from the drop-down 

menu. 

inserting the cut cells 

The column will be moved to the selected 

location, and the columns around it will shift. 

the moved column in its new location 

You can also access the Cut and Insert 

commands by right-clicking the mouse and 

selecting the desired commands from the drop-

down menu. 



accessing commands from the right-click menu 

To hide and unhide a row or column: 

At times, you may want to compare certain 

rows or columns without changing the 

organization of your worksheet. To do this, 

Excel allows you to hide rows and columns as 

needed. In our example we'll hide a few 

columns, but you can hide rows in the same 

way. 

Select the columns you want to hide, right-click 

the mouse, then select Hide from the 

formatting menu. In our example, we'll hide 

columns C, D, and E. 

selecting the hide columns command 

The columns will be hidden. The green column 

line indicates the location of the hidden 

columns. 



the hidden columns 

To unhide the columns, select the columns on 

both sides of the hidden columns. In our 

example, we'll select columns B and F. Then 

right-click the mouse and select Unhide from 

the formatting menu. 

selecting the columns adjacent to the hidden 

columns 

The hidden columns will reappear. 

the unhidden columns 

Wrapping text and merging cells 

Whenever you have too much cell content to 

be displayed in a single cell, you may decide to 

wrap the text or merge the cell rather than 

resize a column. Wrapping the text will 

automatically modify a cell's row height, 

allowing cell contents to be displayed on 



multiple lines. Merging allows you to combine a 

cell with adjacent empty cells to create one 

large cell. 

To wrap text in cells: 

Select the cells you want to wrap. In this 

example, we'll select the cells in column C. 

Click the Wrap Text command on the Home 

tab. 

clicking the Wrap text command on the Home 

tab 

The text in the selected cells will be wrapped. 

the text wrapped within column C 

Click the Wrap Text command again to unwrap 

the text. 

To merge cells using the Merge & Center 

command: 



Select the cell range you want to merge. In our 

example, we'll select A1:F1. 

Click the Merge & Center command on the 

Home tab. In our example, we'll select the cell 

range A1:F1. 

selecting cells to merge 

The selected cells will be merged, and the text 

will be centered. 

the newly merged cells 

To access more merge options: 

If you click the drop-down arrow next to the 

Merge & Center command on the Home tab, 

the Merge drop-down menu will appear. 

other cell merge options 

From here, you can choose to: 



Merge & Center: merges the selected cells into 

one cell and centers the text 

Merge Across: merges the selected cells into 

larger cells while keeping each row separate 

Merge Cells: merges the selected cells into one 

cell but does not center the text 

Unmerge Cells: unmerges selected cells 

You'll want to be careful when using this 

feature. If you merge multiple cells that all 

contain data, Excel will keep only the contents 

of the upper-left cell and discard everything 

else. 

To center across selection: 

Merging can be useful for organizing your data, 

but it can also create problems later on. For 

example, it can be difficult to move, copy, and 

paste content from merged cells. A good 



alternative to merging is Center Across 

Selection, which creates a similar effect without 

actually combining cells. 

Watch the video below to learn why you should 

use Center Across Selection instead of merging 

cells. 

Q13 b) Describe following terms in the 

worksheet 

 Absolute reference and relative reference in 

formula 

 Cell address 

Ans- Relative references 

By default, all cell references are relative 

references. When copied across multiple cells, 

they change based on the relative position of 

rows and columns. For example, if you copy the 

formula =A1+B1 from row 1 to row 2, the 



formula will become =A2+B2. Relative 

references are especially convenient whenever 

you need to repeat the same calculation across 

multiple rows or columns. 

To create and copy a formula using relative 

references: 

In the following example, we want to create a 

formula that will multiply each item's price by 

the quantity. Rather than create a new formula 

for each row, we can create a single formula in 

cell D2 and then copy it to the other rows. We'll 

use relative references so the formula correctly 

calculates the total for each item. 

Select the cell that will contain the formula. In 

our example, we'll select cell D2. 

Screenshot of Excel 2013 



Enter the formula to calculate the desired 

value. In our example, we'll type =B2*C2. 

Screenshot of Excel 2013 

Press Enter on your keyboard. The formula will 

be calculated, and the result will be displayed in 

the cell. 

Locate the fill handle in the lower-right corner 

of the desired cell. In our example, we'll locate 

the fill handle for cell D2. 

Screenshot of Excel 2013 

Click, hold, and drag the fill handle over the 

cells you wish to fill. In our example, we'll select 

cells D3:D12. 

Screenshot of Excel 2013 

Release the mouse. The formula will be copied 

to the selected cells with relative references 

and the values will be calculated in each cell. 



Screenshot of Excel 2013 

You can double-click the filled cells to check 

their formulas for accuracy. The relative cell 

references should be different for each cell, 

depending on its row. 

Screenshot of Excel 2013 

Q14. a) What tools are available to customize 

our PowerPoint presentation? 

Ans -  Changing page setup options 

Presentations are created mainly to project 

either on a projector or more and more 

frequently to a plasma or TV screen. There are 

times when a presentation can be created for 

delivery in different formats. 

 

·         On-screen show (4:3) 



·         Letter Paper (8.5 x 11 in) 

·         Ledger Paper (11 x 17 in) 

·         A3 Paper (297 x 420 mm) 

·         A4 Paper (210 x 297 mm) 

·         B4 (ISO) Paper (250 x 353 mm) 

·         B5 (ISO) Paper (176 x 250 mm) 

·         35mm Slides 

·         Overhead 

·         Banner 

·         On-screen Show (16:9) 

·         On-screen Show (16:10) 

·         Widescreen 

·         Custom  view11 

To select a slide size other than the standard 

one: 



 

In Slide Master View 

Click on Slide Size 

Select from one of the two options 

For more choices, click Custom 

Select one of the options 

view1 

Figure 89- standard or widescreen 

 

view2 

Figure 90 – other options 

 

If you change the orientation to Portrait for the 

presentation it will apply to all the slides. 

 



Changing to view in color/grayscale 

Why change to view the presentation in 

grayscale? You might want to print the 

presentation and to print in colour is more 

expensive than printing to greyscale, so you 

need to see what the presentation looks like in 

grayscale before you print. 

 

view3 

 

Figure 91- colour/grayscale options 

 

On the View Ribbon, click on the option you 

want, Colour, Grayscale or Black and White. 

 



Then from the Grayscale Ribbon select the 

option you want to see: 

 

view4 

 

Figure 92- grayscale options 

 

To get back to the colour view, click Back to 

Colour View. 

 

Navigating using presentation views 

There are several different views in PowerPoint 

as we saw earlier and you can navigate through 

the presentation in each in different ways. 

 

In Normal View 



Click on the thumbnail of the slide you want to 

see 

Use the Vertical Scrollbar to move between 

slides 

Use the up and down arrow keys on the 

keyboard to move one slide backwards or 

forwards 

In Slide Sorter View 

Click on the slide you want to select 

Use the arrow keys to move up, down, left and 

right 

In Reading View 

Use the next and back icons in the status bar to 

move back or forwards or use the menu which 

is accessed from the icon in the middle 

 



view5 

Figure 93- reading view 

 

Pick from the menu – you can use Go to Slide to 

pick the slide number 

 

view6 

Figure 94 – icons 

 

Back and Next icons move between slides. 

 

  

 

In Slide Show view 



When presenting you can use the mouse or the 

arrows on the keyboard to move through the 

presentation one slide at a time. 

 

You can also type the number of the slide you 

want to see and press Enter. 

 

When you hover the mouse over the bottom 

left corner of the slide on display you will notice 

some faint icons, there is a back arrow and 

forward arrow which move you through one 

slide at a time. 

 

view7 

 

Figure 95- slide show icons 



 

Use the fourth icon along to show the slides in 

a presentation view of Slide Sorter View. This 

lays the slides on the screen and you can click 

on the one you want to see 

 

view8 

 

Figure 96- Slide Sorter in presentation view 

 

Use the back arrow at the top left to get back 

to the slide you started from. 

 

To end the slide show, press the Escape Key on 

the keyboard – this takes you back to 

PowerPoint in the edit mode which means that 



your audience will see the back end of your 

presentation. 

 

You can also use the End Presentation option 

which is on the small ellipse icon on the bottom 

left of the slide when you hover the mouse. 

 

view9 

 

Figure 97- end show and stay in presentation 

mode 

 

We hope you enjoyed this article! 

 

PowerPoint 2013 has a lot more exciting 

features. All you have to do is to explore it. 



Aren’t you excited to discover and use these 

features such as how to track changes in 

PowerPoint 2013? 

 

Good luck with your next presentation and 

don’t forget to have a look at the other blog 

articles for more tips: 

 

PowerPoint Presentations: 2 Ways to Make 

Them More Appealing 

3 Simple Ways to Make a Creative Design in 

PowerPoint 

How to use SmartArt graphics in PowerPoint 

2013 

How to use PowerPoint AND engage your 

audience 



How to present a PowerPoint presentation 

online 

How to use masters in Power Point 2013 

How to format text in PowerPoint 

How to use PowerPoint AND engage your 

audience 

Q14 b) Write the steps for the following action 

for creation of power point presentation 

 Open a Blank presentation 

 Save the presentation as Lab1.pptx 

Ans- To create a new presentation: 

When beginning a new project in PowerPoint, 

you'll often want to start with a new blank 

presentation. 

 

Select the File tab to go to Backstage view. 



Clicking the File tab 

Select New on the left side of the window, then 

click Blank Presentation. 

Creating a new presentation 

A new presentation will appear. 

To create a new presentation from a template: 

A template is a predesigned presentation you 

can use to create a new slide show quickly. 

Templates often include custom formatting and 

designs, so they can save you a lot of time and 

effort when starting a new project. 

 

Click the File tab to access Backstage view, then 

select New. 

You can click a suggested search to find 

templates or use the search bar to find 



something more specific. In our example, we'll 

search for the keyword chalkboard. 

Searching for templates 

Select a template to review it. 

Selecting a template 

A preview of the template will appear, along 

with additional information on how the 

template can be used. 

Click Create to use the selected template. 

Creating a new presentation with a template 

A new presentation will appear with the 

selected template. 

It's important to note that not all templates are 

created by Microsoft. Many are created by 

third-party providers and even individual users, 



so some templates may work better than 

others. 

 

To open an existing presentation: 

In addition to creating new presentations, you'll 

often need to open a presentation that was 

previously saved. To learn more about saving 

presentations, visit our lesson on Saving 

Presentations. 

 

Select the File tab to go to Backstage view, then 

click Open. 

Clicking Open 

Click Browse. Alternatively, you can choose 

OneDrive to open files stored on your 

OneDrive. 



Clicking Browse 

The Open dialog box will appear. Locate and 

select your presentation, then click Open. 

Opening a presentation 

Most features in Microsoft Office, including 

PowerPoint, are geared toward saving and 

sharing documents online. This is done with 

OneDrive, which is an online storage space for 

your documents and files. If you want to use 

OneDrive, make sure you’re signed in to 

PowerPoint with your Microsoft account. 

Review our lesson on Understanding OneDrive 

to learn more. 

 

To pin a presentation: 



If you frequently work with the same 

presentation, you can pin it to Backstage view 

for easy access. 

 

Select the File tab to go to Backstage view, then 

click Open. Your Recent Presentations will 

appear. 

Hover the mouse over the presentation you 

want to pin, then click the pushpin icon. 

Pinning a presentation 

The presentation will stay in the Recent 

presentations list until it is unpinned. To unpin 

a presentation, click the pushpin icon again. 

The pinned presentation 

Compatibility Mode 



Sometimes you may need to work with 

presentations that were created in earlier 

versions of PowerPoint, like PowerPoint 2003 

or PowerPoint 2000. When you open these 

types of presentations, they will appear in 

Compatibility Mode. 

 

Compatibility Mode disables certain features, 

so you'll only be able to access commands 

found in the program that was used to create 

the presentation. For example, if you open a 

presentation created in PowerPoint 2003, you 

can only use tabs and commands found in 

PowerPoint 2003. 

 

In the image below, you can see at the top of 

the window that the presentation is in 

Compatibility Mode. This will disable some 



PowerPoint 2016 features, including newer 

types of slide transitions. 

Compatibility mode 

To exit Compatibility Mode, you'll need to 

convert the presentation to the current version 

type. However, if you're collaborating with 

others who only have access to an earlier 

version of PowerPoint, it's best to leave the 

presentation in Compatibility Mode so the 

format will not change. 

You can review this support page from 

Microsoft to learn more about which features 

are disabled in Compatibility Mode. 

To convert a presentation: 

If you want access to all PowerPoint 2016 

features, you can convert the presentation to 

the 2016 file format. 



Note that converting a file may cause some 

changes to the original layout of the 

presentation. 

Click the File tab to access Backstage view. 

Clicking the File tab 

Locate and select the Convert command. 

Converting the presentation to the newest file 

type 

The Save As dialog box will appear. Select the 

location where you want to save the 

presentation, enter a file name, and click Save. 

Saving a new version of the workbook 

The presentation will be converted to the 

newest file type. 

Challenge! 

Open our practice presentation. 



Notice that the presentation opens in 

Compatibility Mode. Convert it to the 2016 file 

format. If a dialog box appears asking if you 

would like to close and reopen the file in order 

to see the new features, choose Yes. 

In Backstage view, pin a file or folder. 

Q15. Write steps for creation of a set of 

PowerPoint slides that demonstrates your skill 

to use 

the tools of PowerPoint. It should include the 

following things 

 Title slide &bullet list 

 Inserting Excel Sheet 

 Clip art and Text 

 Slide show effects 



Ans- When you open PowerPoint, you’ll see some 

built-in themes and templates. A theme is a 

slide design that contains matching colors, 

fonts, and special effects like shadows, 

reflections, and more. 

On the File tab of the Ribbon, select New, and 

then choose a theme. 

PowerPoint shows you a preview of the theme, 

with four color variations to choose from on 

the right side. 

Click Create, or pick a color variation and then 

click Create. 

Shows the Create New presentation from 

Theme dialog in PowerPoint 

Read more: Use or create themes in 

PowerPoint 

Insert a new slide 



On the Home tab, click the bottom half of New 

Slide, and pick a slide layout. 

Shows New Slide button on Home tab of the 

ribbon in PowerPoint 

Read more: Add, rearrange, and delete slides. 

Save your presentation 

On the File tab, choose Save. 

Pick or browse to a folder. 

In the File name box, type a name for your 

presentation, and then choose Save. 

Note: If you frequently save files to a certain 

folder, you can ‘pin’ the path so that it is always 

available (as shown below). 

Save your PowerPoint presentation 

Tip: Save your work as you go. Press Ctrl+S 

often. 



Read more: Save your presentation file 

Add text 

Select a text placeholder, and begin typing. 

Shows adding text to a text field in PowerPoint 

Format your text 

Select the text. 

Under Drawing Tools, choose Format. 

Shows the Drawing Tools tab on the ribbon in 

PowerPoint 

Do one of the following: 

To change the color of your text, choose Text 

Fill, and then choose a color. 

To change the outline color of your text, choose 

Text Outline, and then choose a color. 



To apply a shadow, reflection, glow, bevel, 3-D 

rotation, a transform, choose Text Effects, and 

then choose the effect you want. 

Read more: 

Change the fonts 

Change the color of text on a slide 

Add bullets or numbers to text 

Format text as superscript or subscript 

Add pictures 

On the Insert tab, do one of the following: 

To insert a picture that is saved on your local 

drive or an internal server, choose Pictures, 

browse for the picture, and then choose Insert. 

To insert a picture from the web, choose Online 

Pictures, and use the search box to find a 

picture. 



Insert Pictures dialog in PowerPoint 

Choose a picture, and then click Insert. 

Add shapes 

You can add shapes to illustrate your slide.  

On the Insert tab, select Shapes, and then 

select a shape from the menu that appears. 

In the slide area, click and drag to draw the 

shape. 

Select the Format or Shape Format tab on the 

ribbon. Open the Shape Styles gallery to quickly 

add a color and style (including shading) to the 

selected shape. 

Shape Styles group 

Add speaker notes 

Slides are best when you don’t cram in too 

much information. You can put helpful facts 



and notes in the speaker notes, and refer to 

them as you present. 

To open the notes pane, at the bottom of the 

window, click Notes notes button in 

PowerPoint . 

Click inside the Notes pane below the slide, and 

begin typing your notes. 

Shows the speaker Notes pane in PowerPoint 

Read more: 

Add speaker notes to your slides 

Print slides with or without speaker notes 

Give your presentation 

On the Slide Show tab, do one of the following: 

To start the presentation at the first slide, in 

the Start Slide Show group, click From 

Beginning. 



Shows the Slide Show tab on the ribbon in 

PowerPoint 

If you’re not at the first slide and want to start 

from where you are, click From Current Slide. 

If you need to present to people who are not 

where you are, click Present Online to set up a 

presentation on the web, and then choose one 

of the following options: 

Broadcast your PowerPoint presentation online 

to a remote audience 

View your speaker notes as you deliver your 

slide show. 

Get out of Slide Show view 

To get out of Slide Show view at any time, on 

the keyboard, press Esc. 

Tips for creating an effective presentation 



Consider the following tips to keep your 

audience interested. 

Minimize the number of slides 

To maintain a clear message and to keep your 

audience attentive and interested, keep the 

number of slides in your presentation to a 

minimum. 

Choose an audience-friendly font size 

The audience must be able to read your slides 

from a distance. Generally speaking, a font size 

smaller than 30 might be too difficult for the 

audience to see. 

Keep your slide text simple 

You want your audience to listen to you 

present your information, instead of reading 

the screen. Use bullets or short sentences, and 

try to keep each item to one line. 



Some projectors crop slides at the edges, so 

that long sentences might be cropped. 

Use visuals to help express your message 

Pictures, charts, graphs, and SmartArt graphics 

provide visual cues for your audience to 

remember. Add meaningful art to complement 

the text and messaging on your slides. 

As with text, however, avoid including too 

many visual aids on your slide. 

Make labels for charts and graphs 

understandable 

Use only enough text to make label elements in 

a chart or graph comprehensible. 

Apply subtle, consistent slide backgrounds 

Choose an appealing, consistent template or 

theme that is not too eye-catching. You don't 



want the background or design to detract from 

your message. 

However, you also want to provide a contrast 

between the background color and text color. 

The built-in themes in PowerPoint set the 

contrast between a light background with dark 

colored text or dark background with light 

colored text. 

For more information about how to use 

themes, see Apply a theme to add color and 

style to your presentation. 

Check the spelling and grammar 

To earn and maintain the respect of your 

audience, always check the spelling and 

grammar in your presentation. 

Top of Page 
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Part -2 

Q16. What is the difference between Machine 

Language and High Level Language? 

Ans- Machine language, or machine code, consists 

of binary code and is the only language that is 

directly understood by the computer. ... Both 

machine code and assembly languages are 

hardware specific. A high-level language is a 

programming language that uses English and 

mathematical symbols in its 

instructions.Machine language, or machine 

code, is the only language that is directly 

understood by the computer, and it does not 

need to be translated. All instructions use 

binary notation and are written as a string of 1s 



and 0s. A program instruction in machine 

language may look something like this: 

10010101100101001111101010011011100101   

A high-level language is a programming 

language that uses English and mathematical 

symbols, like +, -, % and many others, in its 

instructions. When using the term 

'programming languages,' most people are 

actually referring to high-level languages. High-

level languages are the languages most often 

used by programmers to write programs. 

Examples of high-level languages are C++, 

Fortran, Java and Python. 

To get a flavor of what a high-level language 

actually looks like, consider an ATM machine 

where someone wants to make a withdrawal of 

$100. This amount needs to be compared to 

the account balance to make sure there are 



enough funds. The instruction in a high-level 

computer language would look something like 

this: 

x = 100   

if balance x:   

print 'Insufficient balance'   

else:   

print 'Please take your money'   

This is not exactly how real people 

communicate, but it is much easier to follow 

than a series of 1s and 0s in binary code. 

There are a number of advantages to high-level 

languages. 

The first advantage is that high-level languages 

are much closer to the logic of a human 

language. 



The second advantage is that the code of most 

high-level languages is portable and the same 

code can run on different hardware 

Q17. Discuss about different data types of C 

programming Language. 

Ans-  To use any language in communication (to 

write/to speak), we need to understand it’s 

grammar first.  In the case of a programming 

language like C, the scenario is same as in the 

case of a communication language. We need to 

understand the grammar of C programming 

language first. So here begins:- 

 

In this article we explain Data Types and 

Constants 

 



The basic grammar of C can be explained 

through:- 

 

Data Types 

Constants 

Variables and Keywords 

Operators and Operands 

Control structures (branching and looping) 

Functions 

Arrays 

Strings 

Pointers 

Structures 

Files 

Data Types 



There are 4 data types in C language. They are:- 

 

int – This data type is used to define an integer 

number (-….-3,-2,-1,0,1,2,3….). A single integer 
occupies 2 bytes. 

char – Used to define characters. A single 

character occupy 1 byte. 

float – Used to define floating point numbers 

(single precision). Occupies 4 bytes. 

double – Used for double precision floating 

point numbers(double precision). Occupies 8 

bytes. 

 

Note:- Single precision and Double precision 

basically differs in the number of digits 

represented after the decimal point. Double 

precision number will represent more digits 



after the decimal point than a single precision 

number. Example:- Single precision – 32.75   

and double precision –  32.7543 

 

Data Types can also be classified as shown in 

the image below – Primitive, Derived and User 

Defined. 

 

C Data Types- C programming tutorial 

 

Image Courtesy 

 

Primitive data types are the first form – the 

basic data types (int,char,float,double). 



Derived data types are a derivative of primitive 

data types known as arrays, pointer and 

function. 

User defined data types are those data types 

which are defined by the user/programmer 

himself. 

 

Note: We will learn about Derived and user 

defined data types in coming chapters. 

 

Data Type Qualifiers 

Each of these data type has got qualifiers. The 

purpose of a qualifier is to manipulate the 

range of a particular data type or its size. The 4 

qualifiers in C are long,short,signed and 

unsigned.First two long and short are called size 



qualifiers and the other two signed and 

unsigned are called sign qualifiers. 

 

Example: int – when declared normally is of 2 

bytes. If it is declared as unsigned int – then its 

range is from 0 to 65535. In other case, if it is 

declared as signed int – then its range is from (-

32767 to 32768). In the case of signed int, one 

bit (MSB) is used to store the sign of the integer 

+/-. This basically means the programmer will 

not be able to display/store a number higher 

than 65535 using unsigned int. Similarly it is not 

possible to manipulate a number beyond -

32767 or +327678 using signed int. 

 

 



The qualifiers long and short are used to 

increase storage size of the data type. 

 

Example: Integer data type int is normally 2 

byte. If you declare it as long int – then its size 

will increase from 2 bytes to 4 bytes. Similarly if 

you declare it as short int – its size will reduce 

from 2 bytes to 1 byte.  

 

The table below describes all data types and 

the most commonly used qualifier 

combinations – with its size,range and format 

specifier. Note: You will learn more about the 

use of format specifiers in coming chapters. 

 

Keyword 

 



Format Specifier 

 

Size 

 

Date Range 

 

char  

%c 

 

1 byte 

 

-128 to +127 

 

int  

%d 



 

2 bytes 

 

0 to 255 

 

float  

%f 

 

4 bytes 

 

-3.4e38 to +3.4e38 

 

double  

%lf 

 



8 bytes 

 

-1.7e38 to +1.7e38 

 

long int  

%ld 

 

4 bytes 

 

-231 to +231 

 

unsigned int  

%u 

 

2 bytes 



 

0 to 65535 

 

long double  

%Lf 

 

16 bytes 

 

-3.4e38 to +3.4e38 

 

Unsigned char  

%c 

 

1 byte 

 



0 to 255 

 

Constants 

There are 4 types of constants in C. 

 

 

Integer constants 

Character constants 

Real/Floating point constants 

String constants 

C programming tutorialImage Courtesy 

 

By definition, a constant is a quantity that does 

not change throughout the execution of a 

program. 



 

Integer Constants 

An integer constant is an integer quantity which 

contains a sequence of digits.It should not have 

a decimal point. Blanks and commas are not 

allowed within an integer constant.An integer 

constant can be either +ve or -ve. The constant 

must lie within the range of the declared data 

type (including qualifiers long,short etc.). 

 

Example of valid integer constants:- 976    8987   

5   -25  etc. 

 

 

Example of invalid integer constants:-  78.43   7-

8   89,76  etc. 



 

An integer constant can be either Decimal, 

Hexa Decimal or Octal. See the table below to 

understand how these 3 different constants are 

defined in C. 

 

Integer Type  

Prefix 

 

Suffix 

 

Example 

 

Hexa Decimal  

Ox 



 

  OxA7B 

Octal  

O 

 

  O54 

Long Hexa Decimal  

Ox 

 

I or L 

 

OxA7BL 

Unsigned Long Hexa Decimal  

Ox 

 



UI or UL 

 

OxA7FUI 

Long Octal  

O 

 

I or L 

 

O54L 

A decimal constant can contain any 

combination of integers from 0 through 9. Ex: 

189      0      75       87 

A hexa decimal constant should begin with 0X 

or 0x. Ex: 0x65F  or 0X7A 

An octal constant should begin with digit 0. It 

can take any digits from 0 through 7. 



Note:- There is no binary integer constant in C 

by default. This means, you cant give a binary 

number directly to program by writing sth like:- 

0b11001011 – which is meaningless and result 

in an error. How ever, programmer can add a 

preprocessor (which we will learn later) to 

accept binary numbers in a program. 

 

Floating Point Constants 

They are also known as real constants. A real 

constant contains a decimal point or an 

exponent. It can be either +ve or -ve. Commas 

and blank space are not allowed within a real 

constant. 

 

 



Examples:– 254.175,      -16.47      -0.5e-7     

+4.1e8 

 

Character Constant 

A character constant is a character which is 

enclosed in single quotes. A character constant 

is of size 1byte and can contain only 1 

character. A character can be an alphabet like 

a,b,A,C etc or a special character like &,^, $, 

#,@ etc or a single digit from 0 through 9. It can 

also be an escape sequence character like 

space ‘ ‘ or a null character ‘\o’  or  a new line 

‘\n’  etc. 

 

Example: ‘A’       ‘a’     ‘ b’      ‘8’     ‘#’  etc. 

 



Each character has a corresponding ASCII value. 

ASCII value is the numeric code of a particular 

character and is stored inside the machine’s 

character set.  

 

 

Note:- It is good that you read more about 

ASCII. There are basically two types of ASCII 

characters known as control characters and 

printable characters. Control characters are 

usually used to control a device using the 

program or to manipulate some logic inside a 

program. Control characters are not usually 

printed to an output device. Printable 

characters are usually printed to a display 

device or a printer. 

 



String Constants 

A string constant is a collection of characters 

enclosed in double quotations “” 

It may contain alphabets, digits, special 

characters and blank space. 

Example:   “Circuits Today123” 

Q18. Find the output of the following 

expressions 

a) X=20/5*2+30-5 b) Y=30 – (40/10+6) +10 c) Z= 

40*2/10-2+10 

Ans-  Solutions for Part 1: Introduction 

1Find these angles in degrees: (a) π/6;   (b) 2π;   
(c) 1 (that’s right, radian angles aren’t 

necessarily fractions or multiples of π). 

Solutions: 

 



(a) (π/6) × (180°/π) = 30° 

 

(b) 2π × (180°/π) = 360° 

 

(c) 1 × (180°/π) = (180/π)° ≈ 57.3° 

 

2Which is the correct definition of an acute 

angle, in interval notation? 

(a) (0°, 90°)   (b) [0°, 90°] 

Answer: (0°, 90°) is 0 to 90 degrees excluding 0° 

and 90°; [0°, 90°] is 0 to 90 degrees including 0° 

and 90°. Acute angles are between 0° and 90° 

exclusive, so the answer is (a) (0°, 90°). 

 

3Two angles of a triangle are 80° and 40°. Fine 

the third angle. 



Solution: The inside angles of a triangle must 

always add to 180°. 80° + 40° = 120°, so to 

make the full 180° the third angle must be 60°. 

 

4A triangle has an angle of 90°. The two short 

sides (next to that angle) are 5 and 12. Find the 

third side. 

Solution: Cue the Pythagorean Theorem! 

 

c² = a² + b² 

 

c² = 5² + 12² 

 

c² = 25 + 144 = 169 

 

c = √169 = 13 



 

5Find these angles in radian measure: (a) 60°   

(b) 126°;   (c) 45°. 

Where possible, give an exact answer rather 

than a decimal approximation. 

 

Solutions: 

 

(a) 60° + (π/180°) = π/3. 

 

(b) 126° × (π/180°) ≈ 2.20 

 

(c) 45° × (π/180°) = π/4 

 



Notice that you don’t have to say “radians” 

when giving an angle in radian measure, though 

it wouldn’t be wrong. In this book, angles in 

degrees have the degree mark (°), so I’ll only 

say “radians” when it’s necessary to avoid 

confusion. 

 

6Who said, “The sum of the square roots of any 

two sides of an isosceles triangle is equal to the 

square root of the remaining side”? Is that 

correct? 

Answer: It was the Scarecrow, in the movie The 

Wizard of Oz (1939). And no, it sounds mathy 

but it’s bosh. It can’t possibly be true for any 

triangle, isosceles or not. (Can you see why?) 

 



7On a circular clock face, which numbers are 

the boundaries of each quadrant? 

Answers: Quadrant I: 12 and 3; Quadrant II: 9 

and 12; Quadrant III: 6 and 9; Quadrant IV: 3 

and 6. 

 

Solutions for Part 2: The Six Functions 

130-60-90 degree triangle. Hypotenuse is 2 

units long, and short side is 1 unit long.Find all 

six functions of the angle 30°. Find sine, cosine, 

and tangent of 60°. 

30-60-90 degree triangle. Hypotenuse is 2 units 

long, and short side is 1 unit long.Solution: First 

off, you need the length of the horizontal side. 

You remember the theorem of Pythagoras: 1² + 

b² = 2², from which you get b = √3. After that, 
it’s just a matter of remembering the 



definitions. If you need a refresher, you’ll find 

sine and cosine at equation 1, tangent at 

equation 4, and the others at equation 5. 

 

sin 30° = 1/2 

 

cos 30° = √3/2 

 

tan 30° = 1/√3 or √3/3 

 

cot 30° = 1/(1/√3) = √3 

 

sec 30° = 1/(√3/2) = 2/√3 or (2 √3)/3 

 

csc 30° = 1/(1/2) = 2 



 

sin 60° = √3/2 

 

cos 60° = 1/2 

 

tan 60° = √3/1 = √3 

 

Since 60° = 90° − 30°, notice that sin 60° = cos 
30°, cos 60° = sin 30°, and tan 60° = cot 30°. 

 

23-4-5 triangle. Angle A between the 4 and 5 

sides, angle B between the 3 ad 5 sides, 90° 

between the 3 and 4 sidesFind sin A, sin B, tan 

A, and tan B. 

Solution: 

 



sin A = 3/5 or 0.6 

 

sin B = 4/5 or 0.8 

 

tan A = 3/4 or 0.75 

 

tan B = 4/3 ≈ 1.33 

 

Incidentally, A ≈ 36.87°, and B ≈ 53.13°. 

 

3triangle with base of 5, angle A to left, then 

side 3, unmarked angle (90°), side 4, and angle 

BA ≈ 53.13°. Find the approximate area of the 

triangle. Hint: the area of a triangle is base × 

height/2. 



Solution: You have the base (5), so you just 

need the height. But sin A = h/3, so h = 3 × sin 

A. The area therefore is (5 × 3 × sin A)/2 ≈ 
5.99999. 

 

Solutions for Part 3: Functions of Special Angles 

1(a) Sketch a 45-45-90° triangle with 

hypotenuse of 1. Label the size of each angle 

and the exact length of each side, not a 

calculator approximation. (Hint: Since the two 

acute angles are equal, the two short sides 

must be equal. That and the Theorem of 

Pythagoras is enough to let you find them.) 

(b) Draw a triangle with all sides equal to 1. If 

all sides are equal, all angles must be equal. 

Knowing that they add to 180°, fill in the value 

of each angle. Now drop a perpendicular from 

the top of the triangle to the middle of the 



opposite side. You now have two 30-60-90° 

triangles with hypotenuse of 1. Fill in the exact 

lengths of the short sides of those two 

triangles. 

 

For the rest of these problems, refer to these 

sketches if you need to. Give exact answers, not 

decimal approximations. 

 

Solution: Check your sketches against the ones 

in the chapter. 

 

2Find tan 45°, cos 45°, sin 90°, cos 30°, sin 30°, 

cos 90°. 

Answers: tan 45° = 1; cos 45° = 1/√2 or √2/2; sin 
90° = 1; cos 30° = √3/2; sin 30° = 1/2; cos 90° = 
0. 



 

3Find sin(π/4), cos(π/6), tan(π/3). 

Answers: sin(π/4) = √2/2 or 1/√2; cos(π/6) = 
√3/2; tan(π/3) = √3 

 

4Find each of the following angles from the 

clues, assuming all the angles are between 0 

and π/2 (0° and 90°) inclusive. Give each 

answer in degrees and radians. sin A = 0;  cos B 

= √3/2;  sin C = 1/2;  sin D = 1;  tan E = 1;  cos F = 
1/2;  tan G = 0;  tan H = √3;  cos I = 1;  cos J = 0. 

Answers: 

 

sin A = 0 ⇒ A = 0° or 0 [radians] 

 

cos B = √3/2 ⇒ B = 30° or π/6 



 

sin C = 1/2 ⇒ C = 30° or π/6 

 

sin D = 1 ⇒ D = 90° or π/2 

 

tan E = 1 ⇒ E = 45° or π/4 

 

cos F = 1/2 ⇒ F = 60° or π/3 

 

tan G = 0 ⇒ G = 0° or 0 [radians] 

 

tan H = √3 ⇒ H = 60° or π/3 

 

cos I = 1 ⇒ I = 0° or 0 [radians] 

 



cos J = 0 ⇒ J = 90° or π/2 

 

5Find sec 60° and cot 30°. Hint: Remember how 

the secant and cotangent are defined in terms 

of the “big three” functions sine, cosine, and 

tangent. 

Solutions: sec 60° = 1/(cos 60°) = 1/(1/2) ⇒ sec 

60° = 2 

 

cot 30° = 1/(tan 30°) = 1/(√3/3) = 3/√3 = √3 ⇒ 

cot 30° = √3 

 

You could also do the second one using 

equation 6: 

 

cot 30° = tan(90°−30°) = tan 60° = √3 



 

6Find sin 120°, cos 120°, and tan 120°. 

Solution: 

 

sin 120° = sin(180° − 120°) = √3/2. 

 

cos 120° = −cos(180° − 120°) = −1/2. 

 

What about the tangent? You don’t have a 

supplement rule for it, but you have another 

way to find the answer: 

 

tan 120° = sin 120° / cos 120° = (√3/2) / (−1/2) = 
−√3 

 



7Even though you can always get the tangent 

of a supplementary angle from the sine and 

cosine, it’s a time-saver to have a rule for the 

supplement of a tangent. The last problem’s 

solution suggested what that rule might be. 

Prove: tan(180° − A) = −tan A. 

 

Proof: 

 

tan(180° − A) = sin(180° − A) / cos(180° − A) 

 

tan(180° − A) = sin A / (−cos A) 

 

tan(180° − A) = −sin A / cos A 

 

tan(180° − A) = −tan A QED 



 

8Find tan 150°. 

Solution: tan 150° = −tan(180° − 150°) = −tan 
30° = −√3/3 

 

Solutions for Part 4: Solving Triangles 

1triangle with angles A and B unknown, C=90°, 

sides a=37, b=66, c unknownYou have a right 

triangle (C = 90°) with short sides a = 88 and b = 

37. Solve the triangle. 

Always start with a sketch. From the sketch, 

you can see right away that this is the SAS case, 

or side-angle-side. To get the third side, you 

need the Law of Cosines, equation 31. 

 

c² = a² + b² − 2ab × cos C 



 

c² = 37² + 88² − 2 × 37 × 88 × cos 90° 

 

Notice that when the included angle C is 90°, 

cos C = 0 and you’ve just got the Pythagorean 

Theorem. 

 

c² = 37² + 88² 

 

c = √37² + 88² 

 

c ≈ 95.5 

 

To find the two angles, you could use the Law 

of Sines, but why not take advantage of the 

right angle and use the tangent? 



 

tan A = 37/88 ⇒ A ≈ 22.8° 

 

Of course tan B = 88/37, but you also know that 

 

A + B = 90° ⇒ B = 90° − A ⇒ B ≈ 67.2° 

 

2(Sketch this problem as you read through it.) 

In a state park, a river flows virtually straight for 

1800 m. You want to build a monorail from A, 

one end of this stretch, to a point C on the far 

shore. You also want to build a foot bridge from 

B, at the other end of this stretch of the river, 

to the same point C on the far shore. At A, the 

angle between your sight lines to B and C is 67°. 

At B, the angle between your sight lines to A 

and C is 38°. 



How long must the monorail and the foot 

bridge be? 

 

Bonus question: If the river has the same width 

all along the stretch from A to B, how wide is it? 

 

triangle as described in problemIn the sketch, b 

is the monorail, a is the foot bridge, and w is 

the width of the river. Since you know two 

angles and the included side, this is the ASA 

case. Although you don’t really care about 

angle C, you have to find it so that you can use 

the Law of Sines to get sides a and b: 

 

C = 180° − 67° − 38° = 75° 

 



Obviously, when I eyeballed the angles A and B 

I didn’t estimate them very well! But that’s 

okay—the sketch is close enough to be useful. 

 

How long is the foot bridge? From the Law of 

Sines, 

 

a/sin A = c/sin C ⇒ a = c sin A/sin C 

 

a = 1800 × sin 67°/sin 75° 

 

Foot bridge: a ≈ 1715 m 

 

How long is the monorail? From the Law of 

Sines, 

 



b/sin B = c/sin C ⇒ b = c sin B/sin C 

 

b = 1800 × sin 38°/sin 75° 

 

Monorail: b ≈ 1147 m 

 

How wide is the river? 

 

w = b sin A 

 

w ≈ 1147 sin 67° 

 

River width: w ≈ 1056 m 

 



3Find the other elements of a triangle with B = 

117°, a = 16 cm, and b = 25 cm. 

triangle as described in problem statementThis 

is the SSA (or ASS) case; refer to the table of 

possibilities for SSA. This problem belongs in 

row 1, column 2: the opposite side is longer 

than the adjacent side, and the known angle is 

> 90°. So there is one and only one solution. 

 

You can use the Law of Sines to find angle A: 

 

(sin A)/a = (sin B)/b 

 

sin A = (a/b) sin B 

 

sin A = (16/25) sin 117° ≈ 0.57024 



 

A ≈ 34.8° 

 

Because this textbook helps you, 

please click to donate! 

Find the third angle by subtracting: 

 

C = 180° − A − B 

 

C ≈ 180° − 34.8° − 117° 

 

C ≈ 28.2° 

 

Finally, use the Law of Sines to find side c: 

 



c/sin C = b/sin B 

 

c = b sin C/sin B 

 

c ≈ 25 sin 28.2°/sin 117° 

 

c ≈ 13.3 cm 

 

4A very modern-looking trivet is a triangular 

shape with sides of 6″, 9″, and 12″. What are 
the three angles? 

triangle with sides a=6, b=9, c=12This is the SSS 

case. First, use the Law of Cosines to find angle 

A: 

 

cos A = (b² + c² − a²) / 2bc 



 

cos A = (9² + 12² − 6²)/(2 × 9 × 12) = 0.875 

 

A ≈ 29.0° 

 

Next, use the Law of Sines to find angle B: 

 

(sin B)/b = (sin A)/a ⇒ sin B = (b/a) sin A 

 

sin B ≈ (9/6) sin 29.0° ≈ 0.72618 

 

B ≈ 46.6° 

 

Finally, subtract the two angles from 180° to 

find the third angle: 



 

C = 180° − A − B 

 

C ≈ 180° − 29.0° − 46.6° 

 

C ≈ 104.5° 

 

That’s not a typo, by the way. A and B both 

happened to round up, but I used the 

unrounded values to find C. You should never 

use rounded numbers in further calculations. 

 

5After you’ve painted your bedroom, you have 

enough paint left to cover 25 ft². You decide to 

paint a triangle on the wall of another room, as 

an accent. Two of the angles should be 30° and 



40°. Find the third angle, and the lengths of the 

three sides. 

triangle with A=30°, B=40°, C=110°The third 

angle is 180° − 30° − 40°, so C = 110°. Make 
your sketch using those three angles. (I did this 

one without measuring the angles, so it’s not 

perfect. But sketches don’t need to be perfect, 

just reasonably close.) 

 

Find side c by using equation 32: 

 

c = √2 area × sin C/(sin A sin B) 

 

c = √2 × 25 × sin 110°/(sin 30° sin 40°) 

 

c ≈ 12.1 ft 



 

Then the Law of Sines gets you the other two 

sides: 

 

a = c sin A/sin C 

 

a ≈ 12.1 sin 30°/sin 110° 

 

a ≈ 6.4 ft 

 

And 

 

b = c sin B/sin C 

 

b ≈ 12.1 sin 40°/sin 110° 



 

b ≈ 8.3 ft 

 

6You drive 6.0 miles along a straight highway, 

then take an exit. It’s a right turn, but you don’t 

notice the angle. 

You’re now driving along a straight side road. 

At the end of 9.8 miles on the side road, you 

turn 135° to the right, on a third road. (If you’re 

visualizing this from above, the 135° change of 

direction corresponds to an angle of 180° − 
135° = 45° in the triangle.) 

 

Assuming that road continues in the same 

direction, how far must you drive to reach your 

starting point? 

 



no solution because first side is too shortThis is 

a difficult sketch to draw, because you don’t 

know the angle of the first turn. But the 

description gives you two sides and a non-

included angle; this is the problematic SSA case. 

You don’t know exactly where side c will meet 

side a. To be more precise, you don’t even 

know if they will meet. 

 

Is it possible for them to meet? Referring back 

to the table of possibilities within SSA, we see 

that we’re in the third row, first column: the 

adjacent side (9.8) is longer than the opposite 

side (6.0), and the known angle (45°) is < 90°. 

Compute 

 

h = b sin A 



 

h = 9.8 sin 45° ≈ 6.9 miles 

 

What’s the significance of this? The shortest 

distance from point C to side c is the segment 

that meets side c in a right angle. In other 

words, to get from point C to side c, the 

shortest possible distance is 6.9 miles. But side 

a is only 6.0 miles long, so it can never meet 

side c. 

 

This problem has no solution. 

 

7You’re laying out a triangular bed for your 

garden. Two sides are 40 m and 60 m, and the 

angle between them is 22°. How long is the 

third side, and what are the other two angles? 



triangle with angle A=22&*deg;, adjacent sides 

c=40 and b=60You know two sides and the 

angle between them. You can use the Law of 

Cosines to get the third side: 

 

a² = b² + c² − 2bc × cos A 

 

a² = 60² + 40² − 2 × 60 × 40 × cos 22° 

 

c²≈ √749.52 ⇒ c ≈ 27.4 m 

 

Next, for angle B you can use the Law of Sines: 

 

(sin B)/b = (sin A)/a ⇒ sin B = (b/a) sin A 

 



sin B ≈ (60/27.4) sin 22° ≈ 0.82099 

 

Your calculator gives about 55.2° as the angle 

whose sine is 0.82099, but that looks wrong 

from the sketch. Clearly B needs to be an 

obtuse angle, so you remember that sin(180° − 
x) = sin x, and you subtract 180° − 55.2° to get 

 

B ≈ 124.8° 

 

See how important a sketch is? Of course your 

sketch probably isn’t perfectly accurate, so you 

treat it as a device to point out that something 

might be wrong, but then you look for a way to 

confirm it. In this case, you have two ways to 

confirm it: 

 



You can use the Law of Cosines, which 

automatically accounts for obtuse angles: 

cos B = (a² + c² − b²)/(2ac) 

 

cos B ≈ (27.4² + 40² − 60²)/(2 × 27.4 × 40) 

 

cos B ≈ −0.57095 ⇒ B ≈ 124.8° 

 

Or, you can compute angle C (below) and then 

recall that angle C must be < B because side c is 

< b. If you made C obtuse, 180° − 33.2° = 
146.8°, it would be > B whether B is acute or 

obtuse. So C must be < 90° and B must be > 90°. 

Now turn to angle C: 

 

(sin C)/c = (sin A)/a ⇒ sin C = (c/a) sin A 



 

sin C ≈ (40/27.4) sin 22° ≈ 0.54732 

 

C ≈ 33.2° 

 

Solutions for Part 5: Functions of Any Angle 

1In which quadrant does the angle −868° 
occur? What about 42 radians? What are the 

signs of their sines, cosines, and tangents? 

Solution: Your task always is to cast out 

multiples of ±360° or ±2π, so that you’re left 

with a positive angle between 0° and 360° (0 

and 2π). 

 

−868° = −1080° + 212°. And 212° is between 
180° and 270°, so −868° occurs in Q III. 



 

42 radians is about 13.37π, or 12π + 1.37π. 
1.37π is obviously between π and 3π/2 (1.5π), 
so 42 (radians) is in Q III. 

 

In Q III, x and y are both negative. Therefore In 

Q III, sine and cosine are negative and tangent 

is positive. 

 

2Rewrite using the smallest possible positive 

angle of the same trig function:   (a) sin 700°   

(b) tan 780°   (c) cos(−390.5) (That’s radians, 

since there’s no degree mark, but be careful! 

The angle is −390.5, not −390.5π.) 

Solution: (a) 700° = 360° + 340°, so sin 700° = 

sin 340°. 340° is in Q IV, where y is negative; 



therefore the sine is negative. The reference 

angle is 20°, so sin 700° = −sin 20°. 

 

(b) 780° = 720° + 60°, so tan 780° = tan 60°. 

 

(c) −390.5 ≈ −124.3π, or −126π + 1.7π; 
therefore cos(−390.5) ≈ cos 1.7π. The angle 
1.7π radians is between 1.5π and 2π, so it’s in Q 

IV, where x is positive and therefore the cosine 

is positive. The reference angle is about 2π − 
1.7π ≈ 0.3π or 0.94, so cos(−390.5) ≈ cos 0.94. 

 

3Rewrite as a function of just A:   (a) cos(720° − 
A)   (b) sin(43π + A) 

Solution: (a) 720° is a multiple of 360°, so 

cos(720° − A) = cos(−A). But cos(−A) = cos A, 
and therefore cos(720° − A) = cos A. 



 

(b) sin(43π + A) = sin(42π + π + A) = sin(π + A). 
sin(π + A) = −sin A, so sin(43π + A) = −sin A. 

 

Solutions for Part 6: The “Squared” Identities 

1If sin A = 3/4, find cos A. 

Solution: 

 

sin² A + cos² A = 1 

 

cos² A = 1 − sin² A = 1 − (3/4)² = 1 − 9/16 

 

cos² A = 7/16 

 

cos A = ±√7/16 ⇒ cos A = √7/4 or −√7/4 



 

Did you remember the ± sign? Just as x² = 9 has 

two solutions, 3 and −3, so any equation in cos² 
A has two solutions. 

 

This makes sense in terms of the functions. 

There are two angles in the interval [0, 2π) or 
[0°, 360°) where sin A = 3/4, one acute and one 

obtuse. The acute one has a positive cosine, 

and the obtuse one has a negative cosine. 

 

2tan B = −2√2. Find sec B. 

Solution: Since this chapter is about the 

“squared” identities, you can be pretty sure 

that one exists that connects tan x and sec x. 

But suppose you met this problem in a different 

context? 



 

Well, you know two identities involving the 

tangent function. The definition, tan B = (sin 

B)/cos B, doesn’t do you a lot of good because 

it’s got sine and cosine mixed together. You 

have a dim memory of a squared identity (if 

you’re like me, it’s dim), but you also know you 

can re-create it easily, from the one squared 

identity that you can’t possibly forget: 

 

sin² B + cos² B = 1 

 

You have sin² B, which will become tan² B if you 

divide both sides by cos² B. 

 

(sin² B)/cos² B + (cos² B)/cos² B = 1/cos² B 



 

tan² B + 1 = sec² B 

 

Success! You have an identity that connects the 

tangent and secant functions. Now you can 

proceed to solve the problem. 

 

(−2√2)² + 1 = sec² B 

 

sec² B = (4 × 2) + 1 = 9 

 

sec B = ±3 

 

You need the ± sign because both (x)² and (−x)² 
are x². But does it make sense in terms of trig? 

Yes, because the tangent is negative in Q II and 



Q IV, while the secant—which has the same 

sign as the cosine, being 1 over the cosine—is 

positive in Q IV but negative in Q II. 

 

3tan C = √15. Find cos C. 

Solution: Wait, what? You don’t have an 

identity connecting tangent and cosine. But you 

do have one connecting tangent and secant, 

and you know that the secant is 1 over the 

cosine, so you can do this one too. 

 

Start with the squared identity from the 

previous problem: 

 

tan² C + 1 = sec² C 

 



(√15)² + 1 = 15 + 1 = 16 ⇒ sec² C = 16 

 

sec C = ±4 ⇒ cos C = 1/4 

 

4tan D =√15, Find sin D. 

Solution: Okay, in the previous problem you got 

from tangent to cosine. But you already know 

how to get from cosine to sine, so you just have 

one more link in the chain. 

 

tan² D + 1 = sec² D 

 

sec² D = (√15)² + 1 = 16 

 

sec D = 4 ⇒ cos D = ±1/4 



 

sin² D + cos² D = 1 

 

sin² D = 1 − cos² D = 1 − (±1/4)² =1 − 1/16 
=15/16 

 

sin D = ±√15/4 

 

5Prove: sin² x = tan² x / (tan² x + 1) 

This assumes that x ≠ π/2 + kπ, for integer k—or 

90° + 180k°, if you prefer—because the tangent 

is undefined for those angles. 

Proof: 

 

tan x = tan x 



 

tan x cos x = tan x cos x 

 

sin x = tan x / sec x 

 

sin² x = tan² x / sec² x 

 

But tan² x + 1 = sec² x, so substituting you have 

 

sin² x = tan² x / (tan² x + 1) QED 

 

Many other proofs are possible. For example, 

you could replace tan² x with sin² x / cos² x in 

the identity you were asked to prove, and then 

simplify the fraction. As long as every step in 



your proof is valid both backwards and 

forwards, your proof is fine. 

 

If your proof starts with an obvious identity and 

then works forward to the identity you we 

asked to prove, as the above proof did, then it 

only matters that all the steps are valid in that 

forward direction. 

 

Solutions for Part 7: Sum and Difference 

Formulas 

1Find sin(−15°) exactly. 

Solution: Start with −15° = 30° − 45° 

 

sin(−15°) = sin(30°−45°) 

 



sin(−15°) = sin 30° cos 45° − cos 30° sin 45° 

 

sin(−15°) = (1/2)(√2/2) − (√3/2)(√2/2) = √2/4 − 
√6/4 

 

sin(−15°) = (√2 − √6)/4 

 

Alternative solution: You could also do this 

using 45°−60°: 

 

sin(−15°) = sin(45°−60°) 

 

sin(−15°) = sin 45° cos 60° − cos 45° sin 60° 

 



sin(−15°) = (√2/2)(1/2) − (√2/2)(√3/2) = √2/4 − 
√6/4 = (√2 − √6)/4 

 

2Find tan 105° exactly. 

Solution: 105° = 60° + 45° 

 

tan 105° = tan(60° + 45°) 

 

tan 105° = (tan 60° + tan 45°)/(1 − tan 60° tan 
45°) 

 

tan 105° = (√3 + 1)/(1 − (√3)(1)) = (√3 + 1)/(1 − 
√3) 

 

Multiply top and bottom by 1 + √3 to 
rationalize the denominator: 



 

tan 105° = (√3 + 1)²/((1 − √3) (1 + √3)) 

 

tan 105° = (3 + 2√3 + 1)/(1 − 3) = (4 + 2√3)/(−2) 
= −2 − √3 

 

3Prove: cos 2A = 2 cos² A − 1. (Hint: 2A = A + A.) 

Proof: 

 

cos 2A = cos(A + A) 

 

cos 2A = cos A cos A − sin A sin A 

 

cos 2A = cos² A − sin² A 

 



But sin² A = 1 − cos² A 

 

cos 2A = cos² A − (1 − cos² A) = cos² A − 1 + cos² 
A 

 

cos 2A = 2 cos² A − 1 QED 

 

4Prove these formulas from equation 22, by 

using the formulas for functions of sum and 

difference. 

(a) cos(−A) = cos A   (I’ve done the first step for 

you.) 

 

cos(−A) = cos(0 − A) 

 

cos(−A) = cos 0 cos A + sin 0 sin A 



 

cos(−A) = 1 cos A + 0 sin A 

 

cos(−A) = cos A QED 

 

(b) tan(π + A) = tan A 

 

tan(π + A) = (tan π + tan A) / (1 − tan π tan A) 

 

tan(π + A) = (0 + tan A) / (1 − 0 tan A) 

 

tan(π + A) = (tan A) / 1 

 

tan(π + A) = tan A QED 

 



(c) sin(π − A) = sin A 

 

sin(π − A) = sin π cos A − cos π sin A 

 

sin(π − A) = 0 cos A − (−1) sin A 

 

sin(π − A) = sin A QED 

 

Solutions for Part 8: Double Angle and Half 

Angle Formulas 

1Use the half-angle formulas to find sin 90° and 

cos 90°. Of course you already know those; this 

problem is just for practice in working with the 

formulas and easy numbers. 



Solution: : 90° is half of 180°. The sine and 

cosine are positive or zero at 90°, so the ± signs 

in the formulas can be treated as positive. 

 

sin(180°/2) = √(1 − cos 180°)/2 = √(1 − (−1))/2 = 
√2/2 

 

sin 90° = 1 

 

cos(180°/2) = √(1 + cos 180°)/2 = √(1 + (−1))/2 = 
√0/2 

 

cos 90° = 0 

 

Why didn’t I ask you to do the same for tan 

90°? 



 

2Use the double-angle formulas to find sin 

120°, cos 120°, and tan 120° exactly. Again, you 

already know these; you’re just getting 

comfortable with the formulas. 

Solution: 120° is double 60°. sin 60° = √3/2, cos 
60° = 1/2, and tan 60° = √3. 

 

sin(2×60°) = 2 sin 60° cos 60° = 2 (√3/2) (1/2) 

 

sin 120° = (√3)/2 

 

cos(2×60°) = 2 cos² 60° − 1 = 2 × (1/2)² − 1 = 
(1/2) − 1 

 

cos 120° = −1/2 



 

tan(2×60°) = 2 tan 60° / (1 − tan² 60°) = 2 √3 / (1 
− (√3)²) = 2 √3 / (1 − 3) = 2 √3 / (−2) 

 

tan 120° = −√3 

 

Alternative solution: You could also divide: 

 

tan 120° = sin 120° / cos 120° = (√3/2) / (−1/2) = 
−√3 

 

33A = 2A + A. Use the double-angle formulas 

along with the formulas for sine or cosine of a 

sum to find formulas for sin 3A in terms of sin A 

only, and cos 3A in terms of cos A only. 



(This is actually done, in a later section, by using 

a different method.) 

 

Solution: First the sine: 

 

sin(2A + A) = sin 2A cos A + cos 2A sin A 

 

sin 3A = (2 sin A cos A) cos A + (1 − 2 sin² A) sin 
A 

 

sin 3A = 2 sin A cos² A + sin A − 2 sin³ A 

 

sin 3A = 2 sin A (1 − sin² A) + sin A − 2 sin³ A 

 

sin 3A = 2 sin A − 2 sin³ A + sin A − 2 sin³ A 



 

sin 3A = 3 sin A − 4 sin³ A, or (3 − 4 sin² A) sin A 

 

Now the cosine: 

 

cos(2A + A) = cos 2A cos A − sin 2A sin A 

 

cos 3A = (2 cos² A − 1) cos A − (2 sin A cos A) sin 
A 

 

cos 3A = 2 cos³ A − cos A − 2 sin² A cos A 

 

cos 3A = 2 cos³ A − cos A − 2 (1 − cos² A) cos A 

 

cos 3A = 2 cos³ A − cos A − 2 cos A  + 2 cos³ A 



 

cos 3A = 4 cos³ A − 3 cos A, or (4 cos² A − 3) cos 
A 

 

4Given sin 3A = (3 − 4 sin² A) sin A and cos 3A = 
(4 cos² A − 3) cos A, find tan 3A in terms of tan 
A only. Check yourself by computing tan(2A+A). 

Solution: 

 

tan 3A = sin 3A / cos 3A 

 

tan 3A = ((3 − 4 sin² A) sin A) / ((4 cos² A − 3) cos 
A) 

 

tan 3A = (sin A / cos A) (3 − 4 sin² A) / (4 cos² A 
− 3) 



 

tan 3A = tan A (3 − 4 sin² A) / (4 cos² A − 3) 

 

Divide top and bottom by cos² A. That at least 

gets rid of sin² A and cos² A, even though it 

introduces secant functions. (You remember 

that 1/cos A = sec A, right?) 

 

tan 3A = tan A (3 sec² A − 4 tan² A) / (4 − 3 sec² 
A) 

 

This may not look better, but it is—before, you 

had to get rid of two unwanted functions; now 

you have only one unwanted function, even 

though it occurs twice. And it’s sec² A. Isn’t 

there some sort of Pythagorean identity 



involving sec² A? Yes, there is! sin² A + cos² A = 

1 ⇒ tan² A +1 = sec² A. 

 

tan 3A = tan A (3 (tan² A + 1) − 4 tan² A) / (4 − 3 
(tan² A + 1)) 

 

tan 3A = tan A (3 tan² A + 3 − 4 tan² A) / (4 − 3 
tan² A − 3) 

 

tan 3A = tan A (3 − tan² A) / (1 − 3 tan² A) 

 

Check: 

 

tan(2A+A) = (tan 2A + tan A) / (1 − tan 2A tan A) 

 



From equation 60, tan 2A = 2 tan A / (1 − tan² 
A). 

 

tan 3A = (2 tan A/(1 − tan² A) + tan A) / (1 − (2 
tan A/(1 − tan² A)) tan A) 

 

Well, that’s a mess! Clean it up by multiplying 

top and bottom by (1 − tan² A). 

 

tan 3A = (2 tan A + (1 − tan² A) tan A) / ((1 − 
tan² A) − 2 tan A tan A) 

 

tan 3A = (3 tan A − tan³ A) / (1 − 3 tan² A) 

 



Factor out tan A from the top of the fraction, 

and it’s the same as what you got with the first 

method: 

 

tan 3A = tan A (3 − tan² A) / (1 − 3 tan² A) 

 

5Find the sine, cosine, and tangent of π/8, 
exactly. 

Solution: π/8 (22½°) is half of π/4 (45°), so you 
want the half-angle formulas. And π/8 is in 

Quadrant I, so all function values will be 

positive. 

 

sin π/8 = √(1 − cos π/4)/2 

 



sin π/8 = √(1 − √2/2)/2 = √(2 − √2)/4 = (½)√2 − 
√2 

 

This expression contains nested radicals. 

Though some nested radicals can be denested, 

following the technique in Denesting Radicals 

(or Unnesting Radicals), this one unfortunately 

cannot. 

 

cos π/8 = √(1 + cos π/4)/2 

 

cos π/8 = √(1 + √2/2)/2 = √(2 + √2)/4 = (½)√2 + 
√2 

 

Now turn to the tangent. You can use the half-

angle formula, or simply divide sine by cosine. 



 

tan π/8 = (sin π/8) / (cos π/8) 

 

tan π/8 = √2 − √2 / √2 + √2 

 

This one can be denested, if you multiply top 

and bottom by √2 − √2. You’d normally do that 

anyway, to rationalize the denominator, but it’s 

a nice bonus that that happens to clean up the 

numerator also. 

 

tan π/8 = √(2 − √2) (2 − √2) / √(2 + √2) (2 − √2) 

 

tan π/8 = (2 − √2) / √(4 − 2) = (2 − √2) / √2 = √2 − 
1 

 



Solutions for Part 9: Inverse Functions 

1The possible output values of Arcsin x include 

±π/2, but the possible output values of Arctan x 
do not. Why can Arctan x never equal −π/2 or 
π/2? 

Solution: Arctan x is an angle whose tangent is 

x, so the possible values of Arctan x are angles 

in Q IV and Q I whose tangents can be taken. 

But tan −π/2 and tan π/2 don’t exist, so they 

are not possible values of Arctan x. 

 

2Find sec(Arcsin x). Remember to make a 

sketch to help you. Pick a value, like x = −0.7, as 
a test case to check your answer. 

right triangle with hypotenuse 1, sides x and 

sqrt(1 minus x squared), angle A opposite side 

xSolution: If angle A is Arcsin x, then we can 



make x the opposite side and 1 the hypotenuse. 

By the theorem of Pythagoras, that makes the 

adjacent side √1 − x². sec A is therefore 
sec(Arcsin x) = 1/√1 − x². 

 

There are no odd powers of x in the answer, so 

we don’t have to worry about the sign of x. 

 

Let’s check that with x = −0.7: Arcsin −0.7 ≈ 
−44.43°, and sec −44.3° = 1/cos −44.3° ≈ 1.40. 
1/√(1 − 0.7²) ≈ 1.40 also, so the formula is right, 
at least for this test case. 

 

3Find sin(Arccos 1/x). Remember to make a 

sketch to help you. Pick a value, like x = 1.3, as a 

test case to check your answer. 



right triangle with hypotenuse x, sides 1 and 

sqrt(x squared minus 1), angle A adjacent to 

side with length 1Solution: If angle A is Arccos 

1/x, we can set the hypotenuse to x and the 

adjacent side to 1 so that cos A = 1/x as 

required. The third side is √x² − 1. 

 

What’s sin A? It must be √x² − 1 / x. But that 
expression has an odd power of x, so we need 

to check the signs. If x is negative, then Arccos x 

will be in Q II. The sine function has all positive 

values in Q II, so we should have a positive 

answer. But as written, the fraction is negative 

if x is negative, so it needs an absolute-value 

sign, just as in Example 3. Our final answer is 

 

sin(Arccos 1/x) = √(x² − 1) / | x | 



 

Let’s check that with x = −1.3: Arccos(1/−1.3) ≈ 
140.28°, in Q II as expected, and sin 140.28° ≈ 
0.64, a positive number like the sines of all 

angles in Q II. √((−1.3)² − 1) / | −1.3 | ≈ 0.64 
also. So the formula is right, at least for this test 

case — even with negative x, putting the angle 

in Q II, the formula returns a positive number, 

as it needs to. 

 

Solutions for Part 10: Fun with Complex 

Numbers 

1Express in a+bi form: (a) 62∠240° (b) 

100e1.17i 

Solutions: (a) 62(cos(240°) + i sin(240°)) ≈ 
−31−53.69i 

 



(b) is apparently in radian measure, since 

there’s no degree mark. 100(cos(1.17) + i 

sin(1.17)) ≈ 39.02+92.08i 

 

2Express in polar form, in both degrees and 

radian measure: (a) −42+17i (b) 100i (c) −14.7 

Solutions: (a) r = √(−42)² + 17² ≈ 45.31. θ = 2 
Arctan(17/(−42+45.31)) ≈ 2.76; multiply by 
180°/π to convert to 157.96°. Answers: 45.31 
cis 157.96° or 45.31 cis 2.76. Of course you 

could use any of the other forms shown in the 

chapter. 

 

(b) and (c) are “gimmes”, since you don’t have 

to compute the radius or the angle. 

(b) 100i = 100∠90° or 100eiπ/2 

(c) −14.7 = 14.7∠180° or 14.7 eiπ 



 

3Find the three cube roots of −i, in a+bi form. 
You’ll be able to give an exact answer, not 

rounded decimals. 

Solution: First, put −i into polar form, which is 
easy enough since −i is on the negative y axis: −i 
= 1 cis 3π/2. Then apply the formula, equation 
83: 

 

(1 cis 3π/2)1/3 = 11/3 cis (π/2 + 2πk/3) for k = 
0, 1, 2 

 

The three angles are π/2, π/2 + 2π/3 = 7π/6, 
and π/2 + 4π/3 = 11π/6 = 3π/2. 

 



(1 cis 3π/2)1/3 = 1 cis π/2, 1 cis 7π/6, 1 cis 
11π/6. 

 

You know exact sines and cosines for any 

multiple of π/6, so you don’t need your 

calculator to convert back to a+bi form: 

 

Cube roots of −i: i, −(√3/2)−(1/2)i, (√3/2)−(1/2)i. 

 

Incidentally, not only is i a cube root of −i, but 
−i is a cube root of i. I’ll let you find the other 

two cube roots of i yourself. 

 

4Find (1.04−0.10i)16. 

Solution: First, put that number into polar form: 

r = √1.04²+0.10² ≈ 1.044796631. Then, find θ = 



2 Arctan(−0.10/(1.04+1.044796631)) ≈ 
−0.0958591471. (My calculator happens to be 

in radian mode, but it doesn’t matter because 

I’ll be converting back to rectangular format 

anyway.) So 

 

(1.04−0.10i)≈ 1.04796631 cis −0.0958591471 

 

And therefore 

 

(1.04−0.10i)16≈ 1.0479663116 cis 
(−16;0.0958591471) 

 

     ≈ 2.016082111 cis (−1.533746354) 

 

     ≈ 0.0746787−2.01469853i   



Q19. Describe the syntax of the following 

statements 

a) If – else statement b) for loop c) while loop 

d) do-while loop 

Ans-   A Loop executes the sequence of statements 

many times until the stated condition becomes 

false. A loop consists of two parts, a body of a 

loop and a control statement. The control 

statement is a combination of some conditions 

that direct the body of the loop to execute until 

the specified condition becomes false. The 

purpose of the loop is to repeat the same code 

a number of times. 

 

In this tutorial, you will learn- 

 

Types of Loops in C 



While Loop in C 

Do-While loop in C 

For loop in C 

Break Statement in C 

Continue Statement in C 

Which loop to Select? 

Types of Loops in C 

Depending upon the position of a control 

statement in a program, looping in C is 

classified into two types: 

 

 

 

1. Entry controlled loop 

 



2. Exit controlled loop 

 

In an entry controlled loop, a condition is 

checked before executing the body of a loop. It 

is also called as a pre-checking loop. 

 

In an exit controlled loop, a condition is 

checked after executing the body of a loop. It is 

also called as a post-checking loop. 

 

 

Sample Loop 

The control conditions must be well defined 

and specified otherwise the loop will execute 

an infinite number of times. The loop that does 

not stop executing and processes the 



statements number of times is called as an 

infinite loop. An infinite loop is also called as an 

"Endless loop." Following are some 

characteristics of an infinite loop: 

 

1. No termination condition is specified. 

 

2. The specified conditions never meet. 

 

The specified condition determines whether to 

execute the loop body or not. 

 

'C' programming language provides us with 

three types of loop constructs: 

 

1. The while loop 



 

2. The do-while loop 

 

3. The for loop 

 

While Loop in C 

A while loop is the most straightforward 

looping structure. Syntax of while loop in C 

programming language is as follows: 

 

while (condition) { 

             statements; 

} 

It is an entry-controlled loop. In while loop, a 

condition is evaluated before processing a body 

of the loop. If a condition is true then and only 



then the body of a loop is executed. After the 

body of a loop is executed then control again 

goes back at the beginning, and the condition is 

checked if it is true, the same process is 

executed until the condition becomes false. 

Once the condition becomes false, the control 

goes out of the loop. 

 

After exiting the loop, the control goes to the 

statements which are immediately after the 

loop. The body of a loop can contain more than 

one statement. If it contains only one 

statement, then the curly braces are not 

compulsory. It is a good practice though to use 

the curly braces even we have a single 

statement in the body. 

 



In while loop, if the condition is not true, then 

the body of a loop will not be executed, not 

even once. It is different in do while loop which 

we will see shortly. 

 

Following program illustrates while loop in C 

programming example: 

 

#include<stdio.h> 

#include<conio.h> 

int main() 

{ 

 int num=1; //initializing the variable 

 while(num<=10) //while loop with 

condition 

 { 



  printf("%d\n",num); 

  num++;  //incrementing operation 

 } 

 return 0; 

} 

Output: 

 

1 

2 

3 

4 

5 

6 

7 

8 



9 

10 

The above program illustrates the use of while 

loop. In the above program, we have printed 

series of numbers from 1 to 10 using a while 

loop. 

 

 

 

We have initialized a variable called num with 

value 1. We are going to print from 1 to 10 

hence the variable is initialized with value 1. If 

you want to print from 0, then assign the value 

0 during initialization. 

In a while loop, we have provided a condition 

(num<=10), which means the loop will execute 

the body until the value of num becomes 10. 



After that, the loop will be terminated, and 

control will fall outside the loop. 

In the body of a loop, we have a print function 

to print our number and an increment 

operation to increment the value per execution 

of a loop. An initial value of num is 1, after the 

execution, it will become 2, and during the next 

execution, it will become 3. This process will 

continue until the value becomes 10 and then it 

will print the series on console and terminate 

the loop. 

\n is used for formatting purposes which means 

the value will be printed on a new line. 

 

Do-While loop in C 

A do...while loop in C is similar to the while loop 

except that the condition is always executed 



after the body of a loop. It is also called an exit-

controlled loop. 

 

Syntax of do...while loop in C programming 

language is as follows: 

 

 do { 

  statements 

} while (expression); 

As we saw in a while loop, the body is executed 

if and only if the condition is true. In some 

cases, we have to execute a body of the loop at 

least once even if the condition is false. This 

type of operation can be achieved by using a 

do-while loop. 

 



In the do-while loop, the body of a loop is 

always executed at least once. After the body is 

executed, then it checks the condition. If the 

condition is true, then it will again execute the 

body of a loop otherwise control is transferred 

out of the loop. 

 

Similar to the while loop, once the control goes 

out of the loop the statements which are 

immediately after the loop is executed. 

 

The critical difference between the while and 

do-while loop is that in while loop the while is 

written at the beginning. In do-while loop, the 

while condition is written at the end and 

terminates with a semi-colon (;) 

 



The following loop program in C illustrates the 

working of a do-while loop: 

 

Below is a do-while loop in C example to print a 

table of number 2: 

 

#include<stdio.h> 

#include<conio.h> 

int main() 

{ 

 int num=1; //initializing the variable 

 do //do-while loop  

 { 

  printf("%d\n",2*num); 

  num++;  //incrementing operation 



 }while(num<=10); 

 return 0; 

} 

Output: 

 

2 

4 

6 

8 

10 

12 

14 

16 

18 

20 



In the above example, we have printed 

multiplication table of 2 using a do-while loop. 

Let's see how the program was able to print the 

series. 

 

 

 

First, we have initialized a variable 'num' with 

value 1. Then we have written a do-while loop. 

In a loop, we have a print function that will 

print the series by multiplying the value of num 

with 2. 

After each increment, the value of num will 

increase by 1, and it will be printed on the 

screen. 

Initially, the value of num is 1. In a body of a 

loop, the print function will be executed in this 



way: 2*num where num=1, then 2*1=2 hence 

the value two will be printed. This will go on 

until the value of num becomes 10. After that 

loop will be terminated and a statement which 

is immediately after the loop will be executed. 

In this case return 0. 

For loop in C 

A for loop is a more efficient loop structure in 

'C' programming. The general structure of for 

loop syntax in C is as follows: 

 

for (initial value; condition; incrementation or 

decrementation )  

{ 

  statements; 

} 



The initial value of the for loop is performed 

only once. 

The condition is a Boolean expression that tests 

and compares the counter to a fixed value after 

each iteration, stopping the for loop when false 

is returned. 

The incrementation/decrementation increases 

(or decreases) the counter by a set value. 

Following program illustrates the for loop in C 

programming example: 

 

#include<stdio.h> 

int main() 

{ 

 int number; 



 for(number=1;number<=10;number++)

 //for loop to print 1-10 numbers 

 { 

  printf("%d\n",number);  //to print 

the number 

 } 

 return 0; 

} 

Output: 

 

1 

2 

3 

4 

5 



6 

7 

8 

9 

10 

The above program prints the number series 

from 1-10 using for loop. 

 

 

 

We have declared a variable of an int data type 

to store values. 

In for loop, in the initialization part, we have 

assigned value 1 to the variable number. In the 

condition part, we have specified our condition 

and then the increment part. 



In the body of a loop, we have a print function 

to print the numbers on a new line in the 

console. We have the value one stored in 

number, after the first iteration the value will 

be incremented, and it will become 2. Now the 

variable number has the value 2. The condition 

will be rechecked and since the condition is 

true loop will be executed, and it will print two 

on the screen. This loop will keep on executing 

until the value of the variable becomes 10. 

After that, the loop will be terminated, and a 

series of 1-10 will be printed on the screen. 

In C, the for loop can have multiple expressions 

separated by commas in each part. 

 

For example: 

 



for (x = 0, y = num; x < y; i++, y--) {  

  statements;  

} 

Also, we can skip the initial value expression, 

condition and/or increment by adding a 

semicolon. 

 

For example: 

 

int i=0; 

int max = 10; 

for (; i < max; i++) { 

  printf("%d\n", i); 

} 



Notice that loops can also be nested where 

there is an outer loop and an inner loop. For 

each iteration of the outer loop, the inner loop 

repeats its entire cycle. 

 

 

Consider the following example, that uses 

nested for loop in C programming to output a 

multiplication table: 

 

#include <stdio.h> 

int main() { 

int i, j; 

int table = 2; 

int max = 5; 

for (i = 1; i <= table; i++) { // outer loop 



  for (j = 0; j <= max; j++) { // inner loop 

    printf("%d x %d = %d\n", i, j, i*j); 

  } 

  printf("\n"); /* blank line between tables */ 

}} 

Output: 

 

1 x 0 = 0 

1 x 1 = 1 

1 x 2 = 2 

1 x 3 = 3 

1 x 4 = 4 

1 x 5 = 5 

 

2 x 0 = 0 



2 x 1 = 2 

2 x 2 = 4 

2 x 3 = 6 

2 x 4 = 8 

2 x 5 = 10 

The nesting of for loops can be done up-to any 

level. The nested loops should be adequately 

indented to make code readable. In some 

versions of 'C,' the nesting is limited up to 15 

loops, but some provide more. 

 

The nested loops are mostly used in array 

applications which we will see in further 

tutorials. 

 

Break Statement in C 



The break statement is used mainly in in the 

switch statement. It is also useful for 

immediately stopping a loop. 

 

We consider the following program which 

introduces a break to exit a while loop: 

 

#include <stdio.h> 

int main() { 

int num = 5; 

while (num > 0) { 

  if (num == 3) 

    break; 

  printf("%d\n", num); 

  num--; 



}} 

Output: 

 

5 

4 

Continue Statement in C 

When you want to skip to the next iteration but 

remain in the loop, you should use the continue 

statement. 

 

For example: 

 

#include <stdio.h> 

int main() { 

int nb = 7; 



while (nb > 0) { 

  nb--; 

  if (nb == 5) 

    continue; 

 printf("%d\n", nb); 

}} 

Output: 

 

6 

4 

3 

2 

1 

So, the value 5 is skipped. 

 



Which loop to Select? 

Selection of a loop is always a tough task for a 

programmer, to select a loop do the following 

steps: 

 

Analyze the problem and check whether it 

requires a pre-test or a post-test loop. 

If pre-test is required, use a while or for a loop. 

If post-test is required, use a do-while loop. 

Summary 

 

Looping is one of the key concepts on any 

programming language. 

A block of looping statements in C are executed 

for number of times until the condition 

becomes false. 



Loops are of 2 types: entry-controlled and exit-

controlled. 

'C' programming provides us 1) while 2) do-

while and 3) for loop. 

For and while loop is entry-controlled loops. 

Do-while is an exit-controlled loop. 

 Q20. Find the output of the following program 

segments 

a) b) c) 

#include <stdio.h> 

int main() 

{ 

 int i; 

 for (i=1; i<2; i++) 

 { 



 printf( "IMS Ghaziabad\n"); 

 } 

} 

#include <stdio.h> 

int main() 

{ 

 int i = 1; 

 while ( i <= 2 ) 

 { 

 printf( "IMS Ghaziabad\n"); 

 i = i + 1; 

 } 

} 

#include <stdio.h> 

void main() 



{ 

 int a = 10, b=100; 

 if( a > b ) 

 printf( "Largest number is %d\n”, a); 

 else 

 printf( "Largest number is %d\n”, b); 

Ans- Output: 

 

 

20 

 

22 

 

24 

 



26 

 

28 

 

 

 

 


